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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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Product comparison

HP LaserJet Enterprise 600 M601 models

M601n printer

CE989A

● Prints up to 45 pages per minute (ppm) on Letter size paper and 43 ppm on A4 size
paper

● Embedded HP Jetdirect networking

● Contains 512 megabytes (MB) of random access memory (RAM). Expandable to
1 gigabyte (GB).

● 4 GB solid-state module memory

● Tray 1 holds up to 100 sheets

● Tray 2 holds up to 500 sheets

● 500-sheet face-down output bin

● 100-sheet face-up output bin

● 4-line color graphical control-panel display

● Hi-speed USB 2.0 port

● Host USB printing port

● Walk-up USB printing port

● One open dual inline memory module (DIMM) slot

M601dn printer

CE990A

Has the same features as the HP LaserJet Enterprise 600 M601n printer, plus the following:

● Duplex-printing accessory for automatic printing on both sides

● Wireless network printing
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HP LaserJet Enterprise 600 M602 models

M602n printer

CE991A

● Prints up to 52 pages per minute (ppm)
on Letter size paper and 50 ppm on A4
size paper

● Embedded HP Jetdirect networking

● Contains 512 megabytes (MB) of
random access memory (RAM).
Expandable to 1 gigabyte (GB).

● 4 GB solid-state module memory

● Tray 1 holds up to 100 sheets

● Tray 2 holds up to 500 sheets

● 500-sheet face-down output bin

● 100-sheet face-up output bin

● 4-line color graphical control-panel
display

● Numeric keypad

● Hi-speed USB 2.0 port

● Host USB printing port

● Walk-up USB printing port

● One open dual inline memory module
(DIMM) slot

● Walkup USB printing port

● Hardware interface pocket

M602dn printer

CE992A

Has the same features as the HP LaserJet Enterprise 600 M602n printer, plus the following:

● Duplex-printing accessory for automatic printing on both sides

● Wireless network printing

M602x printer

CE993A

Has the same features as the HP LaserJet Enterprise 600 M602n printer, plus the following:

● Duplex-printing accessory for automatic printing on both sides

● One additional 500-sheet input tray (Tray 3)

● Wireless network printing
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HP LaserJet Enterprise 600 M603 models

M603n printer

CE994A

● Prints up to 62 pages per minute (ppm)
on Letter size paper and 60 ppm on A4
size paper

● Embedded HP Jetdirect networking

● Contains 512 megabytes (MB) of
random access memory (RAM).
Expandable to 1 gigabyte (GB).

● 4 GB solid-state module memory

● Tray 1 holds up to 100 sheets

● Tray 2 holds up to 500 sheets

● 500-sheet face-down output bin

● 100-sheet face-up output bin

● 4-line color graphical control-panel
display

● Numeric keypad

● Hi-speed USB 2.0 port

● Host USB printing port

● Walk-up USB printing port

● One open dual inline memory module
(DIMM) slot

● Walkup USB printing port

● Hardware interface pocket

M603dn printer

CE995A

Has the same features as the HP LaserJet Enterprise 600 M603n printer, plus the following:

● Duplex-printing accessory for automatic printing on both sides

● Wireless network printing

M603xh printer

CE996A

Has the same features as the HP LaserJet Enterprise 600 M603n printer, plus the following:

● Duplex-printing accessory for automatic printing on both sides

● Wireless network printing

● One additional 500-sheet input tray (Tray 3)

● 250 GB HP Encrypted High Performance Hard Disk (replaces the 4 GB solid-state
module memory that is in the n and dn models)
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Environmental features

Duplex Save paper by using duplex printing as your default print setting.

Print multiple pages per sheet Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Save energy by initiating sleep mode for the product.

HP Smart Web printing Use HP Smart Web printing to select, store, and organize text and graphics from multiple
Web pages and then edit and print exactly what you see onscreen. It gives you the control
you need for printing meaningful information while minimizing waste.

Download HP Smart Web printing from this Web site: www.hp.com/go/smartweb.

Job storage Use the job storage features to manage print jobs. By using job storage, you activate printing
while you are at the shared product, eliminating lost print jobs that are then reprinted.

ENWW Environmental features 5
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Accessibility features
The product includes several features that aid you with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● Print cartridges can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.

● Paper can be loaded in Tray 1 by using one hand.
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Product views

Front view

1

2

3

5

7

4

6

1 Top output bin

2 Control panel (the M602 and M603 models include a numeric keypad)

3 Top cover (provides access to the print cartridge)

4 Walkup USB printing port

5 Tray 1 (pull to open)

6 On/off button

7 Tray 2
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Rear view

       
1

2

34

5

1 Rear output bin (pull to open)

2 Duplex accessory cover (remove this to install the duplex printing accessory)

3 Interface ports

4 Right cover (provides access to the DIMM slot)

5 Hardware integration pocket (M602 and M603 models only)
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Interface ports

1

2

3

4
5

1 RJ-45 Network connection

2 Power connection

3 Host USB connection, for adding fonts and other third-party solutions (this connection might have a removable cover)

4 Slot for a cable-type security lock

5 Hi-speed USB 2.0 connection, for connecting directly to a computer

Serial number and model number location

The label that contains the model and serial numbers is on the back of the product.
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2 Control panel menus

● Control-panel layout

● Retrieve Job from USB menu

● Retrieve Job from Device Memory menu

● Supplies menu

● Trays menu

● Administration menu

● Device Maintenance menu
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Control-panel layout
Use the control panel to obtain product and job status information and to configure the product.

1

3

4

5

6

7

8 10 11

13

14

9

2

12

Number Button or light Function

1 Control-panel display Shows status information, menus, help information, and error messages

2  Up arrow Navigates to the previous item in the list, or increases the value of numeric
items

3  Help button Provides information about the message on the control-panel display

4 OK button ● Saves the selected value for an item

● Performs the action that is associated with the item that is highlighted on
the control-panel display

● Clears an error condition when the condition is clearable

5  Stop button Cancels the current print job and clears the pages from the product

6  Down arrow Navigates to the next item in the list, or decreases the value of numeric items

7  Back arrow Backs up one level in the menu tree or backs up one numeric entry

8  Home button Opens and closes the menus.

9  Ready light ● On: The product is online and ready to accept data to print.

● Off: The product cannot accept data because it is offline (paused) or has
experienced an error.

● Blinking: The product is going offline. The product stops processing the
current job and expels all of the active pages from the paper path.

10  Data light ● On: The product has data to print, but is waiting to receive all of the
data.

● Off: The product has no data to print.

● Blinking: The product is processing or printing the data.
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Number Button or light Function

11  Attention light ● On: The product has experienced a problem. See the control-panel
display.

● Off: The product is functioning without error.

● Blinking: Action is required. See the control-panel display.

12  Folder or STAR (Secure
Transaction Access Retrieval)
button

NOTE: This item is not
included for the M601 models.

Provides quick access to the Retrieve Job menu

13  Backspace button

NOTE: This item is not
included for the M601 models.

Returns values to their defaults and exits the help screen

14 Numeric keypad

NOTE: This item is not
included for the M601 models.

Enter numeric values
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Retrieve Job from USB menu
NOTE: You must enable this feature by using the control-panel menus or the HP Embedded Web
Server before it can be used.

To enable this feature by using the control-panel menus, open the Administration menu, open the
Retrieve From USB Settings sub menu, and then select the Enable option. To enable this feature
by using the HP Embedded Web Server, click the Print tab.

To display: At the product control panel, press the Home  button, and then select the Retrieve
Job from USB menu.

First level Second level Values

Select a file or folder <Job name> Copies
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Retrieve Job from Device Memory menu
To display: At the product control panel, press the Home  button, and then select the Retrieve
Job from Device Memory menu.

First level Second level Values

All Jobs (With PIN) Print Copies

 Print and Delete Copies

 Delete  

All Jobs (No PIN) Print Copies

 Print and Delete Copies

 Delete Yes

No

<Job name with PIN> Print Copies

 Print and Delete Copies

 Delete  

<Job name without PIN> Print Copies

 Print and Delete Copies

 Delete Yes

No
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Supplies menu
To display: At the product control panel, press the Home  button, and then select the Supplies
menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-1  Supplies menu

First level Second level Third level Fourth level Values

Manage Supplies Print Supplies Status    

 Supply Settings Black Cartridge Very Low Settings Stop

Prompt to continue

Continue*

   Low Threshold
Settings

1-100%

Default values for the
CE390A cartridge:

● M601 = 8%

● M602 = 11%

● M603 = 20%

Default values for the
CE390X cartridge:

● M602 = 5%

● M603 = 9%

  Maintenance Kit Very Low Settings Stop

Prompt to continue

Continue*

   Low Threshold
Settings

1-100%

Default = 10%

 Supply Messages Low Message  On*

Off

  Level Gauge  On*

Off

 Reset Supplies New Maintenance Kit  No

Yes

Black Cartridge    The status is displayed.

Maintenance Kit    The status is displayed.
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Trays menu
To display: At the product control panel, press the Home  button, and then select the Trays menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-2  Trays menu

First level Second level Values

Manage Trays Use Requested Tray Exclusively*

First

 Manually Feed Prompt Always*

Unless Loaded

 Size/Type Prompt Display*

Do Not Display

 Use Another Tray Enabled*

Disabled

 Alternative Letterhead Mode Disabled*

Enabled

 Duplex Blank Pages Auto *

Yes

 Tray 2 Model Standard Tray*

Custom Tray

 Image Rotation Standard*

Alternate

 Override A4/Letter Yes*

No

Envelope Feeder Size  Select a size from the list.

Envelope Feeder Type  Select a type from the list.

Tray <X> Size  Select a size from the list.

Tray <X> Type  Select a type from the list.
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Administration menu

Reports menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Reports menu.

Table 2-3  Reports menu

First level Second level

Configuration/Status Pages Administration Menu Map

 Configuration Page

 Supplies Status Page

 Usage Page

 File Directory Page

 Current Settings Page

Other Pages PCL Font List

 PS Font List

General Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the General Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-4  General Settings menu

First level Second level Third level Fourth level Values

Date/Time Settings Date/Time Format Date Format  DD/MMM/YYYY

MMM/DD/YYYY

YYYY/MMM/DD

  Time Format  12 hour (AM/PM)

24 hours

 Date/Time Date Month

Day

Year

Select values from the
lists.
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Table 2-4  General Settings menu (continued)

First level Second level Third level Fourth level Values

  Time Hour

Minute

AM/PM

Select values from the
lists.

  Time Zone  Select the time zone from
the list.

  Adjust for Daylight
Savings

 On*

Off

Energy Settings Sleep Timer Settings Sleep/Auto Off Timer  Enabled*

Disabled

  Sleep/Auto Off After  If you enabled the sleep/
auto off timer, enter a
value between 0 and
120 minutes.

Default value: 30 minutes

  Wake/Auto On
Events

 All Events*

Network port

Power button only

Print Quality Image Registration Adjust Tray <X> Print Test Page  

   X1 Shift

Y1 Shift

X2 Shift

Y2 Shift

-5.00 mm to 5.00 mm

 Adjust Paper Types Select from a list of paper
types that the product
supports. The available
options are the same for
each paper type.

Print Mode Select from a list of print
modes.

   Resistance Mode Normal

Up

Down

   Humidity Mode Normal

High

  Restore Modes   
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Table 2-4  General Settings menu (continued)

First level Second level Third level Fourth level Values

 Optimize Line Detail  Normal*

Alternate 1

Alternate 2

Alternate 3

Off

  Restore Optimize   

 Resolution   300 x 300 dpi

600 x 600 dpi

FastRes 1200*

ProRes 1200

 REt   Off

On*

 Economode   Off*

On

 Toner Density   Range: 1 - 5

Default = 3

Quiet Mode    Off*

On

Jam Recovery    Auto*

Off

On

Manage Stored Jobs Quick Copy Job
Storage Limit

  1-100

Default = 32

 Quick Copy Job Held
Timeout

  Off*

1 Hour

4 Hours

1 Day

1 Week

 Default Folder Name    
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Table 2-4  General Settings menu (continued)

First level Second level Third level Fourth level Values

 Sort Stored Jobs By   Job Name*

Date

Restore Factory
Settings

    

Retrieve From USB Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Retrieve From USB Settings menu.

Table 2-5  Retrieve From USB Settings menu

First level Values

Enable Retrieve from USB Enabled

Disabled*

General Print Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the General Print Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-6  Print Settings menu

First level Second level Values

Manual Feed  Enabled

Disabled*

Courier Font  Regular*

Dark

Wide A4  Enabled

Disabled*

Print PS Errors  Enabled

Disabled*

Print PDF Errors  Enabled

Disabled*
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Table 2-6  Print Settings menu (continued)

First level Second level Values

Personality  Auto*

PCL

PS

PDF

PCL Form Length Range: 5 – 128

Default = 60

 Orientation Portrait*

Landscape

 Font Source Internal*

USB

 Font Number Range: 0 – 110

Default = 0

 Font Pitch Range: 0.44 – 99.99

Default = 10.00

 Font Point Size Range: 4.00 – 999.75

Default = 12.00

 Symbol Set Select from a list of symbol sets.

 Append CR to LF No*

Yes

 Suppress Blank Pages No*

Yes

 Media Source Mapping Standard*

Classic
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Default Print Options menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Default Print Options menu.

In the following table, asterisks (*) indicate the factory default setting.

First level Second level Values

Number of Copies   

Default Paper Size  Select from a list of sizes that the product
supports.

Default Custom Paper Size Unit of Measure Inches

mm

 X Dimension  

 Y Dimension  

Output Bin  Select from a list of available output bins.

Sides  1-sided*

2-sided

2-Sided Format  Book-style*

Flip-style

Edge-To-Edge  Enabled

Disabled*

Display Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Display Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-7  Display Settings menu

First level Second level Values

Display Brightness  Range -10 to 10

Language  Select from a list of languages that the
product supports.

Show IP Address  Display

Hide

Inactivity Timeout  Range: 10 – 300 seconds

Default = 60 seconds
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Table 2-7  Display Settings menu (continued)

First level Second level Values

Clearable Warnings  On

Job*

Continuable Events  Auto continue (10 seconds)*

Press OK to continue

Manage Supplies menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Manage Supplies menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-8  Manage Supplies menu

First level Second level Third level Values

Print Supplies Status    

Supply Settings Black Cartridge Very Low Settings Stop

Prompt to continue

Continue*

  Low Threshold Settings 1-100%

Default values for the CE390A
cartridge:

● M601 = 8%

● M602 = 11%

● M603 = 20%

Default values for the CE390X
cartridge:

● M602 = 5%

● M603 = 9%

 Maintenance Kit Very Low Settings Stop

Prompt to continue

Continue*

  Low Threshold Settings 1-100%

Default = 10%
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Table 2-8  Manage Supplies menu (continued)

First level Second level Third level Values

Supply Messages Low Message  On*

Off

 Level Gauge  On*

Off

Reset Supplies New Maintenance Kit  No

Yes

Manage Trays menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Manage Trays menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-9  Manage Trays menu

First level Values

Use Requested Tray Exclusively*

First

Manually Feed Prompt Always*

Unless Loaded

Size/Type Prompt Display*

Do Not Display

Use Another Tray Enabled*

Disabled

Alternative Letterhead Mode Disabled*

Enabled

Duplex Blank Pages Auto *

Yes

Tray 2 Model Standard Tray

Custom Tray

Image Rotation Standard

Alternate

Override A4/Letter Yes*

No
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Stapler/Stacker Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Stapler/Stacker Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-10  Stapler/Stacker Settings menu

First level Values

Stapling None*

Top left or right

Top left

Top right

Staples Very Low Continue*

Stop

Multi-Bin Mailbox Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Multi-Bin Mailbox Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-11  Multi-Bin Mailbox Settings menu

First level Values

Operation Mode Mailbox*

Stacker

Job Separator

Collator
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Network Settings menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Network Settings menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-12  Network Settings menu

First level Values

I/O Timeout Range: 5 – 300 sec

Default = 15

Jetdirect Menu See the table that follows for details.

Table 2-13  Jetdirect Menu

First level Second level Third level Fourth level Values

Information Print Sec Page   Yes

No*

TCP/IP Enable   On*

Off

 Host Name    

 IPV4 Settings Config Method  Bootp

DHCP*

Auto IP

Manual

  Manual Settings

NOTE: This menu is
available only if you
select the Manual option
under the Config
Method menu.

IP Address Enter the address.

   Subnet Mask Enter the address.

   Default Gateway Enter the address.

  Default IP  Auto IP*

Legacy

  DHCP Release  No*

Yes
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Table 2-13  Jetdirect Menu (continued)

First level Second level Third level Fourth level Values

  DHCP Renew  No*

Yes

  Primary DNS   

  Secondary DNS   

 IPV6 Settings Enable  Off

On*

  Address Manual Settings Enable

Address

  DHCPV6 Policy  Router Specified

Router Unavailable*

Always

  Primary DNS   

  Secondary DNS   

 Proxy Server    

 Proxy Port    

 Idle Timeout    

Security Secure Web   HTTPS Required*

HTTPS Optional

 IPSEC   Keep

Disable*

 802.1X   Reset

Keep*

 Reset Security   Yes

No*

Diagnostics Embedded Tests LAN HW Test  Yes

No*

  HTTP Test  Yes

No*

  SNMP Test  Yes

No*
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Table 2-13  Jetdirect Menu (continued)

First level Second level Third level Fourth level Values

  Data Path Test  Yes

No*

  Select All Tests  Yes

No*

  Execution Time [H]  Range: 1 – 60 hours

Default = 1 hour

  Execute  No*

Yes

 Ping Test Dest Type  IPV4

IPV6

  Dest IPv4   

  Dest IPv6   

  Packet Size   

  Timeout   

  Count   

  Print Results Yes

No

 

  Execute Yes

No

 

 Ping Results Packets Sent   

  Packets Received   

  Percent Lost   

  RTT Min   

  RTT Max   

  RTT Average   

  Ping in Progress Yes

No
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Table 2-13  Jetdirect Menu (continued)

First level Second level Third level Fourth level Values

  Refresh Yes

No

 

Link Speed    Auto*

10T Half

10T Full

100TX Half

100TX Full

1000T Full
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Troubleshooting menu

To display: At the product control panel, press the Home  button, select the Administration
menu, and then select the Troubleshooting menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-14  Troubleshooting menu

First level Second level Third level Values

Print Event Log    

View Event Log    

Print Paper Path Page    

Print Quality Pages Print Fuser Test Page   

Diagnostic Tests Paper Path Sensors Select from a list of the product
sensors.

 

 Paper Path Test Print Test Page  

  Source Select from a list of the available
trays.

  Destination Select from a list of the available
bins.

  Duplex Off*

On

  Copies 1*

10

50

100

500

  Stacking Off

On

 Manual Sensor Test   

 Manual Tray/Bin Sensor
Test

  

 Component Test   

 Print/Stop Test  Range: 0 – 60,000
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Device Maintenance menu

Backup/Restore menu

To display: At the product control panel, press the Home  button, select the Device
Maintenance menu, and then select the Backup/Restore menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-15  Backup/Restore menu

First level Second level Third level Values

Backup Data Scheduled Backups Enable Scheduling Enter a time

  Days Between Enter the number of days

 Backup Now   

 Export Last Backup   

Restore Data   Insert a USB drive that contains
the backup file.

Calibrate/Cleaning menu

To display: At the product control panel, press the Home  button, select the Device
Maintenance menu, and then select the Calibrate/Cleaning menu.

In the following table, asterisks (*) indicate the factory default setting.

Table 2-16  Calibrate/Cleaning menu

First level Second level Values

Cleaning Settings Auto Cleaning Off*

On

 Cleaning Interval From the list, select the number of pages at
which to automatically clean the product.

 Cleaning Size Letter

A4

Print Cleaning Page   
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USB Firmware Upgrade menu

To display: At the product control panel, press the Home  button, select the Device
Maintenance menu, and then select the USB Firmware Upgrade menu.

Insert a USB storage device with a firmware upgrade bundle into the USB port, and follow the on-
screen instructions.

Service menu

To display: At the product control panel, press the Home  button, select the Device
Maintenance menu, and then select the Service menu.

The Service menu is locked and requires a PIN for access. This menu is intended for use by authorized
service personnel.
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3 Software for Windows

● Supported operating systems and printer drivers for Windows

● Select the correct printer driver for Windows

● Change print job settings for Windows

● Remove the printer driver from Windows

● Supported utilities for Windows

● Software for other operating systems
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Supported operating systems and printer drivers for
Windows

The product supports the following Windows operating systems:

● Windows XP (32-bit and 64-bit)

● Windows Server 2008 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

The installation program on the software CD that came with the product supports the following
Windows operating systems:

● Windows XP Service Pack 2 or greater (32-bit)

● Windows Server 2008 (32-bit and 64-bit)

● Windows Server 2008 R2 (64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows 7, including Starter Edition (32-bit and 64-bit)

NOTE: You also can install the product software on 64-bit Windows XP and 64-bit Windows Server
2003 operating systems by using the Windows Add Printer feature.

The product supports the following Windows printer drivers:

● HP PCL 6 (this is the default printer driver)

● HP postscript emulation Universal Print Driver (HP UPD PS)

● HP PCL 5 Universal Print Driver (HP UPD PCL 5)

● HP PCL 6 Universal Print Driver (HP UPD PCL 6)

The printer drivers include online Help that has instructions for common printing tasks and also
describes the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the UPD, see www.hp.com/go/upd.
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Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). The following printer drivers are available at www.hp.com/go/
lj600Series_software.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
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proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● Use this mode if you are installing the driver from a CD for a single computer.

● When installed from the CD that comes with the product, UPD operates like
traditional printer drivers. It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode ● To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.

● Dynamic mode allows you to use a single driver installation, so you can
discover and print to HP products in any location.

● Use this mode if you are installing UPD for a workgroup.
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Change print job settings for Windows

Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box
to open the printer driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.
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Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Remove the printer driver from Windows

Windows XP

1. Click Start, Control Panel, and then Add or Remove Programs.

2. Find and select the product from the list.

3. Click the Change/Remove button to remove the software.

Windows Vista

1. Click Start, Control Panel, and then Programs and Features.

2. Find and select the product from the list.

3. Select the Uninstall/Change option.

Windows 7

1. Click Start, Control Panel, and then under the Programs heading, click Uninstall a
program.

2. Find and select the product from the list.

3. Select the Uninstall option.
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Supported utilities for Windows

HP Web Jetadmin

HP Web Jetadmin is a simple print and imaging peripheral management software tool that helps
optimize product use, control color costs, secure products, and streamline supplies management by
enabling remote configuration, proactive monitoring, security troubleshooting, and reporting of printing
and imaging products.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer) by navigating to the HP Web Jetadmin
host.

HP Embedded Web Server

The product is equipped with the HP Embedded Web Server, which provides access to information
about product and network activities. This information appears in a Web browser, such as Microsoft
Internet Explorer, Netscape Navigator, Apple Safari, or Mozilla Firefox.

The HP Embedded Web Server resides on the product. It is not loaded on a network server.

The HP Embedded Web Server provides an interface to the product that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
HP Embedded Web Server, type the IP address for the product in the address line of the browser. (To
find the IP address, print a configuration page. For more information about printing a configuration
page, see Print information pages on page 146).

For a complete explanation of the features and functionality of the HP Embedded Web Server, see Use
the HP Embedded Web Server on page 147.

HP ePrint

With HP ePrint , you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile
device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-
enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the Web Services tab.

3. Select the option to enable Web Services.

42 Chapter 3   Software for Windows ENWW

http://www.hp.com/go/webjetadmin
http://www.hpeprintcenter.com


Software for other operating systems

OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/go/jetdirectunix_software to install
model scripts using the HP Jetdirect printer installer (HPPI) for UNIX.

For the latest model scripts, go to www.hp.com/go/unixmodelscripts.

Linux For information, go to www.hplip.net.

SAP devices For drivers, go to www.hp.com/go/sap/drivers.

For information, go to www.hp.com/go/sap/print.
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4 Use the product with Mac

● Software for Mac

● Basic print tasks with Mac

● Solve problems with a Mac
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Software for Mac

Supported operating systems and printer drivers for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.5 and 10.6

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For
Mac OS X 10.6, Intel Core Processor Macs are supported.

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog
Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and PDE
files, in combination with the built-in Apple PostScript printer drivers, provide full printing functionality
and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD. Click the product icon, and follow the onscreen instructions.

If you did not add a pirnter during the CD install process, continue with the next step.

3. At the computer, open the Apple menu , click the System Preferences menu, and then click
the Print & Fax icon.

4. Click the plus (+) symbol in the lower left corner of the Printer Names column, select the product
from the Add Printer window, and then make sure that the product driver is listed in the Print
Using area.
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5. Click Add to create the printer queue.

NOTE: For Mac OS X 10.5 and 10.6, the installation procedure should automatically configure
the installed options.

6. Print a page from any program to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.

Install software for Mac computers on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Home  button.

4. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

● Configuration Page
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5. Find the IP address on the Embedded Jetdirect page.

Jetdirect Page HP Color LaserJet
Page 1

6. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address.

Install the software

1. Install the software from the CD. Click the product icon, and follow the onscreen instructions.

If you did not add a pirnter during the CD install process, continue with the next step.

2. At the computer, open the Apple menu , click the System Preferences menu, and then click
the Print & Fax icon.

3. Click the plus (+) symbol in the lower left corner of the Printer Names column.

By default, Mac OS X uses the Bonjour method to find the driver and add the product to the
printer pop-up menu. This method is best in most situations. If Mac OS X cannot find the HP printer
driver, an error message displays. Reinstall the software.

If you are connecting the product to a large network, you might need to use IP printing to connect
rather than Bonjour. Follow these steps:

a. From the Add Printer window, click the IP Printer button.

b. From the Protocol drop-down list, select the HP Jetdirect-Socket option. Enter the IP
address or host name for the product. From the Print Using drop-down list, select the
product model if one is not already selected.

4. Print a page from any program to make sure that the software is correctly installed.
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Remove the printer driver from Mac operating systems

You must have administrator rights to remove the software.

1. Open System Preferences.

2. Select Print & Fax.

3. Highlight the product.

4. Click the minus (-) symbol.

5. Delete the print queue, if necessary.
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Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change printer-driver settings for Mac

Change the settings for all print jobs until the software program is closed

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset
option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax
icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Software for Mac computers

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to a
TCP/IP-based network.

Open the HP Printer Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

The HP Utility consists of pages that you open by clicking in the Configuration Settings list. The
following table describes the tasks that you can perform from these pages. At the top of any page, click
the HP Support link to access technical assistance, online supplies ordering, online registration, and
recycling and return information.

Menu Item Description

Information And
Support

Supplies Status Shows the product supplies status and provides links for online
supplies-ordering.

 Device Information Shows information about the currently selected product.

 File Upload Transfers files from the computer to the product.

 Upload Fonts Transfers font files from the computer to the product.

 Update Firmware Transfers a firmware update file to the product.

 Commands Sends special characters or print commands to the product after the
print job.

Printer Settings Trays Configuration Changes the default tray settings.

 Economode & Toner
Density

Changes toner density to use toner more economically

 Resolution Sets the default print resolution for the product

 Output Devices Manages settings for the optional output accessories

 Duplex Mode Turns on the automatic two-sided printing mode.

 Stored Jobs Manages print jobs that are stored on the product hard disk.

 E-mail Alerts Configures the product to send e-mail notices for certain events.

 Network Settings Configures the network settings, such as the IPv4 and IPv6 settings.

 Supplies
Management

Configures how the product should behave when supplies are
nearing the end of their estimated life.
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Menu Item Description

 Protect Direct Ports Disables printing over USB or parallel ports.

 Additional Settings Provides access to the HP Embedded Web Server.

Supported utilities for Mac

HP Embedded Web Server

The product is equipped with the HP Embedded Web server, which provides access to information
about product and network activities. Access the HP Embedded Web Server from the HP Utility. Open
the Printer Settings menu, and then select the Additional Settings option.

You can also access the HP Embedded Web Server from the Safari Web browser:

1. Select the page icon in the left side of the Safari toolbar.

2. Click the Bonjour logo.

3. In the list of printers, double-click this product. The HP Embedded Web Server opens.

HP ePrint

With HP ePrint , you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile
device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-
enabled product. For more details, go to www.hpeprintcenter.com.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded
Web Server.

2. Click the Web Services tab.

3. Select the option to enable Web Services.

AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications
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To use AirPrint, the product must be connected to a network. For more information about using AirPrint
and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/
lj600Series_firmware.
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Basic print tasks with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by following this procedure:

a. Press the Stop  button on the product control panel.

b. The product prompts you to confirm the deletion. Press the OK button.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the Dock.
Highlight the print job, and then click the Delete button.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size and
Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size
box, and then select the size from the drop-down list.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
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Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Use watermarks with Mac

1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not transparent.

4. From the Pages menu, select whether to print the watermark on all pages or on the first page
only.

5. From the Text menu, select one of the standard messages, or select the Custom option and type
a new message in the box.

6. Select options for the remaining settings.
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Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu.

4. From the Two-Sided menu, select a binding option.

Store jobs with Mac

You can store jobs on the product so you can print them at any time. You can share stored jobs with
other users, or you can make them private.

1. On the File menu, click the Print option.

2. Open the Job Storage menu.
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3. In the Job Storage Mode drop-down list, select the type of stored job.

● Proof and Hold: This feature provides a quick way to print and proof one copy of a job
and then print more copies.

● Personal Job: When you send a job to the product, the job does not print until you request
it at the product control panel. If you assign a personal identification number (PIN) to the job,
you must provide the required PIN at the control panel.

● Quick Copy: If the optional hard disk is installed on the product, you can print the
requested number of copies of a job and then store a copy of the job on the optional hard
disk. Storing the job allows you to print additional copies of the job later.

● Stored Job: If the optional hard disk is installed on the product, you can store a job such as
a personnel form, time sheet, or calendar on the product and allow other users to print the
job at any time. Stored jobs also can be protected by a PIN.

4. To use a custom user name or job name, click the Custom button, and then enter the user name
or the job name.

Select which option to use if another stored job already has that name.

Use Job Name + (1 - 99) Append a unique number to the end of the job name.

Replace Existing File Overwrite the existing stored job with the new one.

5. If you selected the Stored Job or Personal Job option in step 3, you can protect the job with a
PIN. Type a 4-digit number in the Use PIN to Print field. When other people attempt to print
this job, the product prompts them to enter this PIN number.
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Solve problems with a Mac
See Solve product software problems with Mac on page 205.
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5 Connect the product with Windows

● Printer sharing disclaimer

● Connect with USB

● Connect to a network with Windows
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Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Connect with USB
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Directly connect to this computer using USB cable option,
and then click the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button, or click the More Options button to install
more software.

6. On the More Options screen, you can install more software, or click the Exit button.

7. Print a page from any program to make sure that the software is correctly installed.

NOTE: If the installation failed, reinstall the software.
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Connect to a network with Windows
You can configure network parameters from the control panel, the HP Embedded Web Server, or for
most networks, from the HP Web Jetadmin software.

NOTE: HP Web Jetadmin software is not supported on Mac OS X operating systems.

For a complete list of supported networks and for instructions on configuring network parameters from
software, see the HP Jetdirect Embedded Print Server Administrator’s Guide. The guide comes with
products in which an HP Jetdirect embedded print server is installed.

Supported network protocols

Table 5-1  Supported network protocols

Network type Supported protocols

TCP/IP IPv4 and IPv6 networks ● Bonjour

● Simple Network Management Protocol (SNMP) v1, v2, and v3

● Hyper Text Transfer Protocol (HTTP)

● Secure HTTP (HTTPS)

● File Transfer Protocol (FTP)

● Port 9100

● Line printer daemon (LPD)

● Intenet Printing Protocol (IPP)

● Secure IPP

● Web Services Dynamic Discovery (WS Discovery)

● IPsec/Firewall

TCP/IP IPv4 networks only ● Auto IP

● Service Location Protocol (SLP)

● Trivial File Transfer Protocol (TFTP)

● Telnet

● Internet Group Management Protocol (IGMP) v2

● Bootstrap Protocol (BOOTP)/DHCP

● Windows Internet Name Service (WINS)

● IP Direct Mode

● WS Print
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Table 5-1  Supported network protocols (continued)

Network type Supported protocols

TCP/IP IPv6 networks only ● Dynamic Host Configuration Protocol (DHCP) v6

● Multicast Listener Discovery Protocol (MLD) v1

● Internet Control Message Protocol (ICMP) v6

Other supported network protocols ● AppleTalk

● iPrint

Table 5-2  Advanced Security features for network management

Service name Description

IPsec/Firewall Provides network-layer security on IPv4 and IPv6 networks. A firewall provides
simple control of IP traffic. IPsec provides additional protection through
authentication and encryption protocols.

Kerberos Allows you to exchange private information across an open network by assigning a
unique key, called a ticket, to each user who logs on to the network. The ticket is
then embedded in messages to identify the sender.

SNMP v3 Employs a user-based security model for SNMP v3, which provides user
authentication and data privacy through encryption.

SSL/TLS Allows you to transmit private documents via the Internet and guarantee privacy
and data integrity between the client and server applications.

IPsec batch configuration Provides network-layer security through the simple control of IP traffic to and from
the product. This protocol provides the benefits of encryption and authentication
and allows for multiple configurations.
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Install the product on a wired network with Windows

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the Home  button.

4. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

● Configuration Page
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5. Find the IP address on the Embedded Jetdirect page.

Jetdirect Page HP Color LaserJet
Page 1

6. IPv4: If the IP address is 0.0.0.0, or 192.0.0.192, or 169.254.x.x, you must manually configure
the IP address. Otherwise, the network configuration was successful.

IPv6: If the IP address begins with "fe80:", the product should be able to print. If not, you must
manually configure the IP address.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option.

5. From the list of available printers, select the printer that has the correct IP address.

6. At the end of the installation, click the Finish button, or click the More Options button to install
more software.

7. Print a page from any program to make sure that the software is correctly installed.
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Configure network settings with Windows

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It
has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the embedded Web server, type the IP address into the address line of a Web browser.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the network password

Use the embedded Web server to set a network password or change an existing password.

1. Open the embedded Web server, click the Networking tab, and click the Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.
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Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv4 address, subnet mask, and
default gateway.

1. At the control panel, press the Home  button.

2. Open each of the following menus:

a. Administration

b. Network Settings

c. Jetdirect Menu

d. TCP/IP

e. IPV4 Settings

f. Config Method

g. Manual

h. Manual Settings

i. IP Address, Subnet Mask, or Default Gateway

3. Use the numeric keypad, or press the up arrow  or the down arrow  to increase or decrease
the number for the first byte of the IP address, subnet mask, or default gateway.

4. Press the OK button to move to the next set of numbers. To move to the previous set of numbers,
press the back arrow .

5. Repeat steps 3 and 4 until the IP address, subnet mask, or default gateway is complete, and then
press the OK button to save the setting.
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Manually configure IPv6 TCP/IP parameters from the control panel

Use the control-panel Administration menus to manually set an IPv6 address.

1. At the control panel, press the Home  button.

2. To enable manual configuration, open each of the following menus:

a. Administration

b. Network Settings

c. Jetdirect Menu

d. TCP/IP

e. IPV6 Settings

f. Address

g. Manual Settings

h. Enable

Select the On option, and then press the OK button.

3. To configure the address, open each of the following menus:

● Administration

● Network Settings

● Jetdirect Menu

● TCP/IP

● IPV6 Settings

● Address

Use the numeric keypad, or press the up arrow  or the down arrow  to enter the address. Press
the OK button.

NOTE: If you are using the arrow buttons, you must press the OK button after entering each
digit.
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Link speed and duplex settings

The link speed and communication mode of the print server must match the network. For most situations,
leave the product in Auto mode. Incorrect changes to the link speed and duplex settings might prevent
the product from communicating with other network devices. If you need to make changes, use the
product control panel.

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. At the control panel, press the Home  button.

2. Open each of the following menus:

a. Administration

b. Network Settings

c. Jetdirect Menu

d. Link Speed

3. Select one of the following options.

Setting Description

Auto The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Half 10 megabytes per second (Mbps), half-duplex operation

10T Full 10 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

100TX Full 100 Mbps, full-duplex operation

100TX Auto Limits auto-negotiation to a maximum link speed of 100 Mbps

1000T Full 1000 Mbps, full-duplex operation

4. Press the OK button. The product turns off and then on.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size in Windows

● Supported paper sizes

● Supported paper types

● Tray and bin capacity

● Load paper trays

● Configure trays

● Select an output bin
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause poor print quality,
increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

Store paper in the original package to prevent exposing the paper to moisture and other damage. Do
not open the package until you are ready to use the paper.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that are
approved for use in laser printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of labels.
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Media type Do Do not

Transparencies ● Use only transparencies that are
approved for use in laser printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Use coated paper in the
temperature and humidity range for
this product.

● Do not use glossy or coated paper
designed for use in inkjet products.

● Do not use coated paper in
extremely high or low humidity
environments.

All paper types ● Store paper in the original
packaging.

● Store paper in a dust-free area.

● Do not use paper that is curled.

● Do not use paper that has been
stored in a humid environment.
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Change the printer driver to match the paper type
and size in Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports a number of paper sizes, and it adapts to various media.

NOTE: To obtain best results, select the correct paper size and type in the printer driver before
printing.

Table 6-1  Supported paper and print media sizes

Size and dimensions Tray 1 Tray 2
and the
optional
500-
sheet
trays

Optional
1,500-sheet
tray

Optional
envelope
feeder

Optional
duplexer

Optional
stacker and
stapler/
stacker

Optional
5-bin
mailbox

Letter

216 x 279 mm (8.5 x 11
in)

 

A4

210 x 297 mm (8.27 x
11.69 in)

 

Legal

216 x 356 mm (8.5 x 14
in)

 

Executive

184 x 267 mm (7.24 x
10.51 in)

 

(Stacker only)

A5

148 x 210 mm (5.83 x
8.27 in)

 

(Stacker only)

8.5 x 13

216 x 330 mm (8.5 x 13
in)

  

(Stacker only)

B5 (JIS)

182 x 257 mm (7.17 x
10.12 in)

 

(Stacker only)

Double Postcard (JIS)

148 x 200 mm (5.8 x
7.9 in)

      

16K

197 x 273 mm (7.8 x
10.8 in)

  

(Stacker only)
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Table 6-1  Supported paper and print media sizes (continued)

Size and dimensions Tray 1 Tray 2
and the
optional
500-
sheet
trays

Optional
1,500-sheet
tray

Optional
envelope
feeder

Optional
duplexer

Optional
stacker and
stapler/
stacker

Optional
5-bin
mailbox

Custom

76 x 127 mm to 216 x
356 mm

(3.0 x 5.0 in to
8.5 x 14 in)

      

Custom

148 x 210 mm to 216 x
356 mm

(5.83 x 8.27 in to
8.5 x 14 in)

  

(Stacker only)

Envelope Commercial
#10

105 x 241 mm (4.13 x
9.49 in)

     

Envelope DL ISO

110 x 220 mm (4.33 x
8.66 in)

     

Envelope C5 ISO

162 x 229 mm (6.37 x
9.01 in)

     

Envelope B5 ISO

176 x 250 mm (6.92 x
9.84 in)

     

Envelope Monarch
#7-3/4

98 x 191 mm (3.9 x 7.5
in)

     

1 Custom sizes cannot be stapled, but they can be stacked in the output bins.
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
lj600Series.

Supported paper types for input options

Paper type Tray 1 Tray 2 Optional 500-
sheet trays

Optional
1,500-sheet
tray

Optional
envelope
feeder

Any Type

Plain  

Light 60-74g  

Cardstock 176-220g   

Transparency   

Labels   

Letterhead  

Preprinted  

Prepunched  

Colored  

Rough  

Bond  

Recycled  

HP EcoSMART Lite  

Envelope    
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Supported paper types for output options

Paper type Standard top
bin (face-
down)

Rear bin (face-
up)

Optional
duplexer

Optional
stacker or
stapler/stacker

Optional 5-bin
mailbox

Any Type

Plain

Light 60-74g

Cardstock 176-220g    

Transparency    

Labels    

Letterhead

Preprinted

Prepunched

Colored

Rough

Bond

Recycled

HP EcoSMART Lite

Envelope    
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Tray and bin capacity

Tray or bin Paper type Specifications Quantity

Tray 1 Paper and cardstock Range:

60 g/m2 (16 lb) bond to
200 g/m2 (54 lb) bond

Maximum stack height: 10 mm
(0.39 in)

Equivalent to 100 sheets of
75 g/m2 (20 lb) bond

Envelopes Less than 60 g/m2 (16 lb) bond
to 90 g/m2 (24 lb) bond

Up to 10 envelopes

Labels Maximum 0.23 mm (0.009 in)
thick

Maximum stack height: 10 mm
(0.39 in)

Transparencies Minimum 0.13 mm (0.005 in)
thick

Maximum stack height: 10 mm
(0.39 in)

Tray 2 and the optional 500-
sheet trays

Paper and cardstock Range:

60 g/m2 (16 lb) bond to
135 g/m2 (36 lb) bond

Equivalent to 500 sheets of
75 g/m2 (20 lb) bond

Labels Maximum 0.13 mm (0.005 in)
thick

Maximum stack height: 54 mm
(2.1 in)

Transparencies Minimum 0.13 mm (0.005 in)
thick

Maximum stack height: 54 mm
(2.1 in)

Optional 1,500-sheet tray Paper Range:

60 g/m2 (16 lb) bond to
135 g/m2 (36 lb) bond

Equivalent to 1,500 sheets of
75 g/m2 (20 lb) bond

Optional envelope feeder Envelopes Less than 60 g/m2 (16 lb) bond
to 90 g/m2 (24 lb) bond

Up to 75 envelopes

Standard top bin Paper  Up to 500 sheets of 75 g/m2

(20 lb) bond

Rear bin Paper  Up to 100 sheets of 75 g/m2

(20 lb) bond

Optional duplexer Paper Range:

60 g/m2 (16 lb) bond to
120 g/m2 (32 lb) bond

 

Optional stacker Paper  Up to 500 sheets of 75 g/m2

(20 lb) bond

Optional stapler/stacker Paper  Stapling: Up to 20 print jobs of
up to 15 pages each

Stacking: Up to 500 sheets of
75 g/m2 (20 lb) bond

Optional 5-bin mailbox Paper  Up to 500 sheets of 75 g/m2

(20 lb) bond
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Load paper trays

Load Tray 1

NOTE: The product might print at a slower speed when using Tray 1.

CAUTION: To avoid jams, do not load trays while the product is printing. Do not fan the paper.
Fanning can cause misfeeds.

1. Open Tray 1.  

2. Pull out the tray extension.  
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3. Load the paper into the tray. Make sure that
the paper fits under the tabs and below the
maximum-height indicators.

 
2

4. Adjust the side guides so that they lightly touch
the paper stack but do not bend the paper.

 
2

Load Tray 2 or an optional 500-sheet tray

CAUTION: To avoid jams, do not load trays while the product is printing.

CAUTION: Do not fan the paper. Fanning can cause misfeeds.

1. Pull the tray out and lift up slightly to remove it
from the product.
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2. Pinch the release lever that is located on the
left guide and slide the side guides to the
correct paper size.

 

3. Pinch the release lever that is located on the
rear paper guide and slide it to the correct
paper size.

 

4. Load the paper into the tray. Make sure that
the stack is flat at all four corners and that the
top of the stack is below the maximum-height
indicators.

 

5. Slide the tray completely into the product.  
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Load an optional 1,500-sheet tray

The optional 1,500 sheet tray adjusts for Letter, A4, and Legal sizes. The product automatically senses
which size is loaded if the tray guides are correctly adjusted.

CAUTION: To avoid jams, do not load trays while the product is printing.

CAUTION: Do not fan the paper. Fanning can cause misfeeds.

1. Press the release and open the door of the
1,500-sheet tray.

 

2. If paper is in the tray, remove it. When paper
is in the tray, the guides cannot be adjusted.

 

3. Pinch the guides at the front of the tray and
slide them to the correct paper size.
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4. Load the paper into the tray. Load complete
reams at one time. Do not divide reams into
smaller sections.

 

5. Make sure that the height of the stack does not
exceed the maximum-height indicators on the
guides and that the front edge of the stack is
aligned with the arrows.

 

6. Close the door on the tray.  
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Paper orientation for loading trays

Load letterhead, preprinted, or prepunched paper

If a duplexer is installed, or if a stapler/stacker is installed, the product alters the way the images for
each page are arranged. If you are using paper that requires a specific orientation, load it according
to the information in the following table.

Tray Single-sided printing,
no stapler/stacker

Duplex printing, no
stapler/stacker

Single-sided printing
with the stapler/
stacker

Duplex printing with
the stapler/stacker

Tray 1 Face-up

Top edge leading into the
product

Face-down

Bottom edge leading into
the product

Face-up

Bottom edge leading into
the product

Face-down

Top edge leading into the
product

All other trays Face-down

Top edge at the front of
the tray

Face-up

Bottom edge at the front
of the tray

Face-down

Bottom edge at the front
of the tray

Face-up

Top edge at the front of
the tray
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Load envelopes

Load envelopes into Tray 1 or the optional envelope feeder with the front of the envelope facing up,
and the short, postage-edge leading into the product.
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Configure trays
The product automatically prompts you to configure a tray for type and size in the following situations:

● When you load paper into the tray

● When you specify a particular tray or paper type for a print job through the printer driver or a
software program and the tray is not configured to match the print-job’s settings

NOTE: The prompt does not appear if you are printing from Tray 1, and it is configured for the Any
Size paper size and the Any Type paper type settings. In this situation, if the print job does not
specify a tray, the product prints from Tray 1, even if the paper size and type settings in the print job
do not match the paper loaded in Tray 1.

Configure a tray when loading paper

1. Load paper in the tray. Close the tray if you are using a tray other than Tray 1.

2. The tray configuration message appears.

3. Press the OK button to accept the detected size. Or, press the back arrow  to choose a different
configuration, and continue with the following steps.

4. To modify the tray configuration, press the down arrow  to highlight the correct size, and then
press the OK button.

NOTE: The product automatically detects most paper sizes in trays other than Tray 1.

5. Press the down arrow  to highlight the correct type, and then press the OK button.

Configure a tray to match print job settings

1. In the software program, specify the source tray, the paper size, and the paper type.

2. Send the job to the product.

If the tray needs to be configured, a prompt appears on the control-panel display.

3. If the displayed size is not correct, press the back arrow . Press the down arrow  to highlight
the correct size, or highlight the Custom option.

To specify a custom size, first press the down arrow  to highlight the correct unit of measure.
Then set the X and Y dimensions by using the numeric keypad or by pressing the up arrow  or
the down arrow .

4. If the displayed paper type is not correct, press the back arrow , and then press the down arrow
 to highlight the paper type.
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Configure a tray from the control panel

You can also configure the trays for type and size without a prompt from the product.

1. Press the Home  button.

2. Open the Trays menu.

3. Press the down arrow  to highlight the size or type setting for the desired tray, and then press the
OK button.

4. Press the up arrow  or the down arrow  to highlight the size or type. If you select a custom
size, select the unit of measure, and then set the X dimension and the Y dimension.

5. Press the OK button to save your selection.
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Select an output bin
The product has four output locations: the top (standard) output bin, the rear output bin, the optional
stacker or stapler/stacker, and the optional 5-bin mailbox.

Print to the top (standard) output bin

The top output bin collects paper face-down, in the correct order. The top output bin should be used for
most print jobs, including transparencies. To use the top output bin, be sure that the rear output bin is
closed. To avoid jams, do not open or close the rear output bin while the product is printing.

Print to the rear output bin

The product always prints to the rear output bin if it is open. Paper that is printed to this bin will exit
face-up, with the last page on top (reverse order).

Printing from Tray 1 to the rear output bin provides the straightest path. Opening the rear output bin
might improve performance with the following items:

● Envelopes

● Labels

● Small custom-size paper

● Postcards

● Paper heavier than 120 g/m2 (32 lb)

Opening the rear output bin makes the duplexer (if installed) and the top output bin unavailable. To
avoid jams, do not open or close the rear output bin while the product is printing.

ENWW Select an output bin 87



1. To open the rear output bin, grasp the handle
at the top of the bin, and pull the bin down.

 

 

2. Slide out the extension.  

Print to the optional stacker or stapler/stacker

The optional stacker or optional stapler/stacker can hold up to 500 sheets of paper (20-lb paper). The
stacker accepts standard and custom paper sizes. The stapler/stacker accepts standard and custom
paper sizes, but only Letter, Legal, and A4 sizes can be stapled. Do not try to send other types of print
media, such as labels or envelopes.

NOTE: When a stapler/stacker is installed, the product automatically rotates the printed images
180° on all paper sizes, regardless of whether the job is stapled. Paper types that must be printed in
the correct orientation, such as letterhead or prepunched paper, need to be loaded in a different
direction.

To print to the optional stacker or optional stapler/stacker, select the option in the program, in the
printer driver, or at the printer control panel.

Before you use the optional stacker or optional stapler/stacker, ensure that the printer driver is set to
recognize it. You need to set this setting only once.
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Windows

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.

4. In the Installable Options area, set the Automatic Configuration item to Update Now.

Mac

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax
icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.

Print to the 5-bin mailbox

The optional 5-bin mailbox provides five output bins that can be configured from the control panel to
sort print jobs in a variety of ways.

1. Press the Home  button.

2. Open the following menus:

● Administration

● Multi-Bin Mailbox Settings

● Operation Mode

3. Press the down arrow  to highlight how the 5-bin mailbox sorts jobs:

Mailbox Each bin is assigned to a user or group of users. This is the default setting.

Stacker The product uses all of the bins to stack copies of a job. Jobs are sent to the bottom bin first, and
then to the next highest bin, and so forth. When all bins are full, the product stops.
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Job Separator Each print job is sent to a different bin. Jobs are sent to an empty bin, starting with the top bin and
continuing to the bottom bin.

Collator The product sorts copies of a single print job into separate bins.

4. Press the OK button to select the option.
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7 Print cartridges

The information contained herein is subject to change without notice. For the latest User Guide
information go to www.hp.com/support/lj600Series_manuals.

● Print cartridge information

● Supplies views

● Manage print cartridges

● Replacement instructions

● Solve problems with print cartridges
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Print cartridge information

Feature Description

Part numbers ● Standard-capacity print cartridge: CE390A

● High-capacity print cartridge: CE390X

Accessibility ● The print cartridge can be installed and removed by using one hand.

Environmental
features

● Recycle print cartridges by using the HP Planet Partners return and recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.
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Supplies views

Print cartridge views

1

2

3

1 Print cartridge memory chip

2 Plastic shield

3 Sealing tape
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Manage print cartridges
Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Change settings for print cartridges

Print when a print cartridge is at estimated end of life

● Black cartridge low message: The product indicates when a supply level is low. Actual print
cartridge life remaining may vary. Consider having a replacement available to install when print
quality is no longer acceptable. The supply does not need to be replaced now.

● Black cartridge very low message: The product indicates when a supply level is very low.
Actual supply life remaining may vary. Consider having a replacement available to install when
print quality is no longer acceptable. The supply does not need to be replaced now unless the
print quality is no longer acceptable. Print-quality problems may occur when using a supply that is
at its estimated end of life.

Once an HP print cartridge has reached “Very Low”, HP’s Premium Protection Warranty on that
print cartridge has ended. HP's Premium Protection Warranty applies only to the print cartridge for
this product.

Enable or disable the Very Low Settings options from the control panel

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new cartridge.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● Manage Supplies

● Supply Settings

● Black Cartridge

● Very Low Settings

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the cartridge is very low, but
to continue printing.

NOTE: Using the Continue setting allows printing beyond Very Low without customer
interaction and can result in unsatisfactory print quality.

● Select the Stop option to set the product to stop printing until you replace the cartridge.

● Select the Prompt to continue option to set the product to stop printing and prompt you to
replace the cartridge. You can acknowledge the prompt and continue printing.

94 Chapter 7   Print cartridges ENWW



If you select the Stop or Prompt to continue option, the product stops printing when it reaches the
Very Low threshold. When you replace the cartridge, the product automatically resumes printing.

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is
no longer acceptable, consider replacing the print cartridge.

NOTE: This feature is available with the PCL 6 printer driver for Windows. If you are not using that
driver, you can enable the feature by using the HP Embedded Web Server.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Store and recycle supplies

Recycle supplies

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps
to resolve the problem.
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Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Replacement instructions

Replace the print cartridge

1. Open the top cover.  

2. Remove the used print cartridge from the
product.

 

3. Remove the new print cartridge from the bag.
Place the used print cartridge in the bag for
recycling.
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4. Grasp both sides of the print cartridge and
distribute the toner by gently rocking the print
cartridge.

CAUTION: Do not touch the shutter or the
surface of the roller.

 

5. Remove the shipping lock and the shipping
tape from the new print cartridge. Discard the
lock and tape according to local regulations.

 

6. Align the print cartridge with the tracks inside
the product, insert the print cartridge until it is
firmly seated, and then close the top cover.

After a short time, the control panel should
display the Ready message.

 

7. Installation is complete. Place the used print
cartridge in the box in which the new cartridge
arrived. See the enclosed recycling guide for
recycling instructions.

 

8. If you are using a non-HP print cartridge,
check the product control panel for further
instructions.
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Replace staples

Replace staples if the product control-panel display prompts you with a message. If the stapler runs out
of staples, jobs continue to print to the stapler/stacker, but they are not stapled.

1. On the right side of the stapler/stacker, turn
the stapler unit toward the front of the product
until the unit clicks into the open position.
Grasp the blue staple-cartridge handle and
pull the cartridge out of the stapler unit.

 

2. Insert the new staple cartridge into the stapler
unit and rotate the stapler unit toward the rear
of the product until the unit snaps into place.

 

ENWW Replacement instructions 99



Perform preventive maintenance

To ensure optimum performance from the product, replace certain parts when the Replace
Maintenance Kit message appears on the control-panel display.

The kit includes the following items:

● Fuser

● Transfer roller

● Plastic tool for removing the old transfer roller

● Eight feed rollers and four pickup rollers

● Installation instructions

NOTE: The maintenance kit is a consumable item and is not covered under the original product
warranty or under most extended warranties. Installing the maintenance kit is the customer's
responsibility.

After a maintenance kit is installed, the maintenance-kit counter must be reset.

Reset the maintenance-kit counter

NOTE: Perform this procedure only after a maintenance kit has been installed. Do not use this
procedure to temporarily clear the Replace Maintenance Kit message.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● Manage Supplies

● Reset Supplies

● New Maintenance Kit

3. Select the Yes option to reset the maintenance-kit counter.
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Solve problems with print cartridges

Check the print cartridges

Check the print cartridge, and replace it if necessary, if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft or EconoMode print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge.

Genuine HP print cartridge 1. The product control panel or the supplies status page indicates Very Low
status when the cartridge has reached the end of its designated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repeating defects information in this document to identify the cause of the
problem.
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Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print
cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem has resolved.
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Repeating defects

If defects repeat at any of the following approximate intervals on the page, the print cartridge might be
damaged.

● 37 mm

● 63 mm

● 94 mm

Print the Supplies Status page

The Supplies Status page indicates the estimated life remaining in print cartridges. It also lists the
part number for the correct genuine HP print cartridge for your product so you can order a replacement
print cartridge, as well as other useful information.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

3. Select the Supplies Status Page option, and then press the OK button to print the report.
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Interpret control panel messages for supplies

Table 7-1  Supplies status messages

Control panel message Description Recommended action

10.0X.Y0 Supply memory error The product cannot read or write to the print
cartridge memory chip or the memory chip is
missing from the print cartridge.

Reinstall the print cartridge, or install a new
print cartridge.

Black cartridge low The product indicates when a supply level is
low. Actual print cartridge life might vary.
You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable.

If print quality is no longer acceptable,
replace the print cartridge. Consider
purchasing a replacement cartridge so it is
available when the installed cartridge has
reached the end of its estimated life.

Black cartridge very low The product indicates when a supply level is
very low. Actual print cartridge life might
vary. You do not need to replace the print
cartridge at this time unless print quality is no
longer acceptable. After an HP supply has
reached the very low threshold, the
HP Premium Protection Warranty for that
supply has ended.

If print quality is no longer acceptable,
replace the print cartridge.

Incompatible <supply> The indicated supply is not compatible with
this product.

Replace the supply with one that is designed
for this product.

Incompatible supplies Supply items are installed that were not
designed for this product. The product
cannot print with these supplies installed.

Press the down arrow  button to identify
the incompatible supplies. Install supplies
that are designed for this product.

Maintenance Kit low The maintenance kit is low. The actual supply
life remaining might vary. Consider having a
replacement maintenance kit available to
install when print quality is no longer
acceptable. You do not need to replace the
maintenance kit at this time unless print
quality is no longer acceptable.

If print quality is no longer acceptable,
replace the maintenance kit. Instructions are
included with the maintenance kit.

Maintenance Kit very low The maintenance kit is very low. The actual
supply life remaining might vary. You do not
need to replace the maintenance kit at this
time unless print quality is no longer
acceptable. After an HP supply has reached
the very low threshold, the HP Premium
Protection Warranty for that supply has
ended.

If print quality is no longer acceptable,
replace the maintenance kit. Instructions are
included with the maintenance kit.

Replace <supply> The product indicates when a supply level is
at its estimated end of life. The actual life
remaining might be different than the
estimation. Have a replacement supply
available to install when print quality is no
longer acceptable. The supply does not need
to be replaced now unless the print quality is
no longer acceptable. After an HP supply
has reached its approximated end of life,
HP’s Premium Protection Warranty on that
supply ends.

Replace the specified supply.

Or, configure the product to continue
printing by using the Manage Supplies
menu.
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Table 7-1  Supplies status messages (continued)

Control panel message Description Recommended action

Replace supplies Two or more supplies are at the estimated
end of life. The actual life remaining might
be different than the estimation. Consider
having replacement supplies available to
install when print quality is no longer
acceptable. The supply does not need to be
replaced now unless the print quality is no
longer acceptable. After an HP supply has
reached its approximated end of life, HP’s
Premium Protection Warranty on that supply
ends.

Press the down arrow  button to see which
supplies need to be replaced.

Or, configure the product to continue
printing by using the Manage Supplies
menu.

Supplies low This message appears when at least two
supplies have reached the low threshold. The
actual supply life remaining might vary. Press
the down arrow  button to see which
supplies are low. You do not need to replace
the supplies at this time unless print quality is
no longer acceptable. After an HP supply
has reached the very low threshold, the
HP Premium Protection Warranty for that
supply has ended.

To continue printing, either replace the
supply or reconfigure the product by using
the Manage Supplies menu on the control
panel.

Supplies very low This message appears when at least two
supplies have reached the very low
threshold. Press the down arrow  button to
see which supplies are low. The actual
supply life remaining might vary. You do not
need to replace the supplies at this time
unless print quality is no longer acceptable.
After an HP supply has reached the very low
threshold, the HP Premium Protection
Warranty for that supply has ended.

To continue printing, either replace the
supply or reconfigure the product by using
the Manage Supplies menu on the control
panel.

Unsupported supply installed The print cartridge is for a different
HP product.

If print quality is no longer acceptable,
replace the print cartridge.

Used supply in use The print cartridge has been previously used. If you believe you purchased a genuine
HP supply, go to www.hp.com/go/
anticounterfeit.
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8 Print tasks

● Cancel a print job with Windows

● Basic print tasks with Windows

● Use HP ePrint

● Additional print tasks with Windows

● Walk-up USB printing

ENWW 107



Cancel a print job with Windows
NOTE: If the print job is too far into the printing process, you might not have the option to cancel it.

1. If the print job is currently printing, cancel it by following this procedure:

a. Press the Stop  button on the product control panel.

b. The product prompts you to confirm the cancellation. Press the OK button.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or
print spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and
then click Printers and Faxes. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware
and Sound, click Printer. Double-click the product icon to open the window, right-
click the print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  

Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.
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Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments are
lost.
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5. Select the print options for the new shortcut.  

6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK
button.
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Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size, specify the dimensions, and click the OK button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper type
that you are using.

Select the paper tray with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.
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Print on both sides (duplex) with Windows

Manually print on both sides with Windows

NOTE: This information applies only to products that do not have an automatic duplexer.

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides (manually)
check box. Click the OK button to print the
first side of the job.

 

5. Retrieve the printed stack from the output bin,
and place it with the printed-side facing up in
Tray 1.

 

6. On the control panel, press the OK button to
print the second side of the job.

 

Automatically print on both sides with Windows

NOTE: This information applies only to products that have an automatic duplexer.

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to print the job.
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Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the
Pages per sheet drop-down list.

 

5. Select the correct Print page borders,
Page order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.
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Use HP ePrint
Use HP ePrint to print documents by sending them as an e-mail attachment to the product's e-mail
address from any e-mail enabled device.

NOTE: The product must be connected to a network and have Internet access to use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. Type the product IP address into the address line of a Web browser to open the
HP Embedded Web Server.

b. Click the Web Services tab.

c. Select the option to enable Web Services.

2. Use the HP ePrintCenter Web site to define security settings and to configure default print settings
for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product e-mail address that is before the @
symbol.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If it
expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the e-mail
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

3. To print a document, attach it to an e-mail message sent to the product's e-mail address.
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Additional print tasks with Windows

Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Paper type drop-down list, click the
More... option.

 

5. Expand the list of Type is: options.  
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6. Expand the list of Other options.  

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print on special paper, labels, or transparencies with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

7. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. In the Special pages area, click the Print
pages on different paper option, and
then click the Settings button.

 

5. In the Pages in document area, select
either the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists.
Click the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click
the Left binding or Right binding option.
The Pages per sheet option automatically
changes to 2 pages per sheet.
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Select output options with Windows

Select an output bin with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Output tab.  

4. In the Output Bin Options area, select a
bin from the Bin drop-down list.

 

Select staple options with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Output tab.  

4. In the Output Options area, select an
option from the Staple drop-down list.
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Use job storage features with Windows

The following job-storage modes are available for print jobs:

● Proof and Hold: This feature provides a quick way to print and proof one copy of a job and
then print more copies.

● Personal Job: When you send a job to the product, the job does not print until you request it at
the product control panel. If you assign a personal identification number (PIN) to the job, you must
provide the required PIN at the control panel.

● Quick Copy: If the optional hard disk is installed on the product, you can print the requested
number of copies of a job and then store a copy of the job on the optional hard disk. Storing the
job allows you to print additional copies of the job later.

● Stored Job: If the optional hard disk is installed on the product, you can store a job such as a
personnel form, time sheet, or calendar on the product and allow other users to print the job at
any time. Stored jobs also can be protected by a PIN.

CAUTION: If you turn off the product, all Quick Copy, Proof and Hold, and Personal Job
types of stored jobs are deleted. To permanently store the job and prevent the product from deleting it
when space is needed for something else, select the Stored Job option in the driver.

Create a stored job with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Job Storage tab.  

4. Select a Job Storage Mode option.  

Print a stored job

Use the following procedure to print a job that is stored in the product memory.

1. At the product control panel, press the Home  button.

2. Open the Retrieve Job from Device Memory menu.

3. Select your username, and then select the name of the job or select the All Jobs (With PIN) or
All Jobs (No PIN) option.

4. Enter the PIN if required, and then select the Print option. Select the Copies option to adjust the
number of copies.

Delete a stored job

When you send a stored job to the product memory, the product overwrites any previous jobs with the
same user and job name. If a job is not already stored under the same user and job name, and the
product needs additional space, the product might delete other stored jobs starting with the oldest. You
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can change the number of jobs that can be stored from the General Settings menu on the product
control panel.

Use this procedure to delete a job that is stored in the product memory.

1. At the product control panel, press the Home  button.

2. Open the Retrieve Job from Device Memory menu.

3. Select your username, and then select the name of the job or select the All Jobs (With PIN) or
All Jobs (No PIN) option.

4. Select the Delete option. The product prompts you to confirm the deletion.

Set job storage options with Windows

Print one copy for proof before printing all the copies

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Proof and Hold option.

Temporarily store a personal job on the product and print it later

NOTE: The product deletes the job after you print it.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Personal Job option.

5. Optional: In the Make Job Private area, click the PIN to print option, and enter a 4-digit
personal identification number (PIN).

6. Print the job at any time from the product control panel.

Temporarily store a job on the product

NOTE: This option is available if the optional hard disk is installed in the product.

NOTE: The product stores the job until you turn the product off.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Quick Copy option.

The requested number of copies are printed immediately, and you can print more copies from the
product control panel.

Permanently store a job on the product

NOTE: This option is available if the optional hard disk is installed in the product.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Stored Job option.

Make a permanently stored job private so that anyone who tries to print it must provide a
PIN

NOTE: This option is available if the optional hard disk is installed in the product.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. In the Job Storage Mode area, click the Stored Job option or the Personal Job option.

5. In the Make Job Private area, click the PIN to print option, and enter a 4-digit personal
identification number (PIN).

NOTE: To print the job or to delete it, you must provide the PIN at the product control panel.

Receive notification when someone prints a stored job

NOTE: Only the person who created the stored job receives notification. You do not receive
notification when someone prints a stored job that another person has created.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. In the Job Notifications Options area, click the Display Job ID when printing option.
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Set the user name for a stored job

Follow this procedure to change the user name for a stored job.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. In the User Name area, click the User name option to use the Windows default user name. To
provide a different user name, click the Custom option and type the name.

Specify a name for the stored job

Follow this procedure to change the default name for a stored job.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Job Storage tab.

4. Select the job storage mode that you want.

5. To automatically generate the job name associated with the stored document, in the Job Name
area, click the Automatic option. The driver uses the document file name, if it is available. If the
document has no file name, the driver uses the software program name or a time stamp for the job
name.

To specify a job name, click the Custom option and type the name.

6. Select an option from the If job name exists drop-down list.

● Select the Use Job Name + (1-99) option to add a number to the end of the existing
name.

● Select the Replace Existing File option to overwrite a job that already has that name.

Print special jobs with Windows

Set the duplex alignment

For documents that are printed on both sides, such as brochures, set the registration for the tray before
printing to ensure that the front and back of the page are aligned.

1. At the product control panel, press the Home  button.

2. Open the following menus:

a. Administration

b. General Settings
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c. Print Quality

d. Image Registration

e. Adjust Tray <X>

3. Select the Print Test Page item, and then press the OK button.

4. Follow the instructions on the test page to complete the adjustment.
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Walk-up USB printing
This product features walk-up USB printing, so you can quickly print files without sending them from a
computer. The product accepts standard USB storage accessories in the USB port on the front of the
product. You can print the following types of files:

● .pdf

● .prn

● .pcl

● .ps

● .cht

1. Insert the USB storage accessory into the USB
port on the front of the product.

NOTE: You might need to remove the cover
from the USB port.

NOTE: If the product does not recognize the
USB accessory, try using another type of USB
accessory. Because of differences in USB
specifications, the product does not recognize
all types of USB accessories.

 

2. At the product control panel, press the Home
 button.

 

3. Open the Retrieve Job from USB menu.  

4. Select the name of the document that you want
to print.

 

5. If you need to adjust the number of copies,
select the Copies option, and then enter the
number of copies.

 

6. Press the OK button to print the document.  
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9 Manage and maintain

● Print information pages

● Use the HP Embedded Web Server

● Use HP Web Jetadmin software

● Product security features

● Economy settings

● Install memory and internal USB devices

● Clean the product

● Product updates
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Print information pages
Information pages provide details about the product and its current configuration. Use the following
procedure to print or view the information pages:

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● Reports

3. Select the name of the report you want to review, scroll up to the Print option, and then press the
OK button to print the report.

First level Second level Description

Configuration/Status Pages Administration Menu Map Shows the layout and current settings of the control-panel
menu items.

 Configuration Page Shows the product settings and installed accessories.

 Supplies Status Page Shows the approximate remaining life for the supplies;
reports statistics on total number of pages and jobs
processed, serial number, page counts, and maintenance
information.

HP provides approximations of the remaining life for the
supplies as a customer convenience. The actual remaining
supply levels might be different than the approximations
provided.

 Usage Page Shows a count of all paper sizes that have passed through
the product; lists whether they were simplex or duplex, and
reports the page count.

 File Directory Page Shows the file name and folder name for files that are
stored in the product memory.

 Current Settings Page Shows the current settings for each option in the
Administration menu.

Other Pages PCL Font List Prints the available PCL fonts.

 PS Font List Prints the available PS fonts.
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Use the HP Embedded Web Server
Use the HP Embedded Web Server to view product status, configure product network settings, and
manage printing functions from your computer instead of from the product control panel. The following
are examples of what you can do using the HP Embedded Web Server:

● View product status information.

● Determine the remaining life for all supplies and order new ones.

● View and change tray configurations.

● View and change the product control-panel menu configuration.

● View and print internal pages.

● Receive notification of product and supplies events.

● View and change network configuration.

To use the HP Embedded Web Server, you must have Microsoft Internet Explorer 5.01 or later or
Netscape 6.2 or later for Windows, Mac OS, and Linux (Netscape only). Netscape Navigator 4.7 is
required for HP-UX 10 and HP-UX 11. The HP Embedded Web Server works when the product is
connected to an IP-based network. The HP Embedded Web Server does not support IPX-based product
connections. You do not have to have Internet access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically
available.

Open the HP Embedded Web Server by using a network
connection

1. Identify the product IP address or host name, which is listed on the product configuration page.
Follow these steps to print the product configuration page:

a. At the product control panel, press the Home  button.

b. Open the following menus:

◦ Administration

◦ Reports

◦ Configuration/Status Pages

◦ Configuration Page

c. Press the OK button.

d. Find the IP address or host name on the Jetdirect page.

2. In a supported Web browser on your computer, type the product IP address or host name in the
address/URL field.
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HP Embedded Web Server features

Information tab

Table 9-1  HP Embedded Web Server Information tab

Menu Description

Device Status Shows the product status and shows the estimated life remaining of HP supplies. The
page also shows the type and size of paper set for each tray. To change the default
settings, click the Change Settings link.

Job Log Shows a summary of all jobs the product has processed.

Configuration Page Shows the information found on the configuration page.

Supplies Status Page Shows the status of the supplies for the product.

Event Log Page Shows a list of all product events and errors. Use the HP Instant Support link (in
the Other Links area on all HP Embedded Web Server pages) to connect to a set
of dynamic Web pages that help you solve problems. These pages also show
additional services available for the product.

Usage Page Shows a summary of the number of pages the product has printed, grouped by
size, type, and paper print path.

Device Information Shows the product network name, address, and model information. To customize
these entries, click the Device Information menu on the General tab.

Print Upload a print-ready file from your computer to print. The product uses the default
print settings to print the file.

Printable Reports and Pages Lists the internal reports and pages for the product. Select one or more items to print
or view.

General tab

Table 9-2  HP Embedded Web Server General tab

Menu Description

Control Panel Administration
Menu

Shows the menu structure of the Administration menu on the control panel.

NOTE: You can configure settings on this screen, but the HP Embedded Web
Server provides more advanced configuration options than are available through
the Administration menu.

Alerts Set up e-mail alerts for various product and supplies events.

AutoSend Configure the product to send automated e-mails regarding product configuration
and supplies to specific e-mail addresses.

Control Panel Snapshot Shows an image of the current screen on the control-panel display.

Edit Other Links Add or customize a link to another Web site. This link appears in the Other Links
area on all HP Embedded Web Server pages.

Ordering Information Enter information about ordering replacement print cartridges. This information
appears on the supplies status page.
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Table 9-2  HP Embedded Web Server General tab (continued)

Menu Description

Device Information Name the product and assign an asset number to it. Enter the name of the primary
contact who will receive information about the product.

Language Set the language in which to display the HP Embedded Web Server information.

Date and Time Set the date and time or synchronize with a network time server.

Sleep Schedule Set or edit a wake time, sleep time, and sleep delay for the product. You can set a
different schedule for each day of the week and for holidays.

Backup and Restore Create a backup file that contains product and user data. If necessary, you can use
this file to restore data to the product.

Restore Factory Settings Restore product settings to the factory defaults.

Solution Installer Install third-party software programs that can enhance the product functionality.

Firmware upgrade Download and install product firmware upgrade files.

Statistics Services Provides connection information about third-party job-statistics services.

Print tab

Table 9-3  Print tab

Menu Description

Retrieve from USB Setup Enable or disable the Retrieve Job from USB menu on the control panel.

Manage Stored Jobs Enable or disable the ability to store jobs in the product memory, and configure job-
storage options.

Adjust Paper Types Adjust the print mode for each type of paper that the product supports.

General Print Settings Establish default settings for print jobs.

Manage Trays View or change paper type and size settings for each tray, and adjust general
settings for all trays.

Troubleshooting tab

Table 9-4  HP Embedded Web Server Troubleshooting tab

Menu Description

Reports and Tests Print a variety of reports to help you solve problems with the product.

Calibrations Select an option to calibrate the product immediately.

Firmware upgrade Download and install product firmware upgrade files.

Restore Factory Settings Restore product settings to factory defaults.
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Security tab

Table 9-5  HP Embedded Web Server Security tab

Menu Description

General Security Configure an administrator password so you can restrict access to certain features
on the product.

Enable or disable the walk-up USB printing port on the control panel or the USB
connectivity port on the formatter for printing directly from a computer.

Access Control Configure access to product functions for specific individuals or groups. Also select
the method by which individuals sign in to the product.

Protect Stored Data Configure and manage the internal hard drive for the product. This product includes
an encrypted hard drive for maximum security.

Configure settings for jobs that are stored on the product hard drive.

Certificate Management Install and manage security certificates for access to the product and the network.

HP Web Services tab

Use the HP Web Services tab to configure and enable HP Web Services for this product. You must
enable HP Web Services to use the HP ePrint feature.

Networking tab

Use the Networking tab to change network settings for the product when it is connected to an IP-
based network. This tab does not appear if the product is connected to other types of networks.

Other Links list

NOTE: You can configure which items appear in the Other Links list by using the Edit Other
Links menu on the General tab. The following items are the default links.

Table 9-6  HP Embedded Web Server Other Links list

Menu Description

Product Support Connects to the support site for the product, from which you can search for help
regarding various topics.

HP Instant Support Connects you to the HP Web site to help you find solutions to product problems.
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Use HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP devices, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product
features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to
learn more about updates.

ENWW Use HP Web Jetadmin software 151

http://www.hp.com/go/webjetadmin


Product security features

Security statements

The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

IP Security

IP Security (IPsec) is a set of protocols that control IP-based network traffic to and from the product.
IPsec provides host-to-host authentication, data integrity, and encryption of network communications.

For products that are connected to the network and have an HP Jetdirect print server, you can configure
IPsec by using the Networking tab in the HP Embedded Web Server.

Secure the HP Embedded Web Server

Assign an administrator password for access to the product and the HP Embedded Web Server so that
unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the Security tab.

3. Open the General Security menu.

4. In the Username field, type the name to associate with the password.

5. Type the password in the New Password box, and type it again in the Verify password
box.

NOTE: If you are changing an existing password, you must first type the existing password in
the Old Password field.

6. Click the Apply button. Make note of the password and store it in a safe place.

Encryption support: HP Encrypted High Performance Hard Disks (xh
models only)

This product includes an encrypted hard disk. This hard disk provides hardware-based encryption so
you can securely store sensitive print, copy, and scan data without impacting product performance.
This hard disk uses the latest Advanced Encryption Standard (AES) and has versatile time-saving
features and robust functionality.

Use the Security menu in the HP Embedded Web Server to configure the disk.
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For more information about the encrypted hard disk, see the HP High-Performance Secure Hard Disk
Setup Guide.

1. Go to www.hp.com/support.

2. Type Secure Hard Disk into the search box and click the >> button.

3. Click the HP Secure High Performance Hard Disk Drive link.

4. Click the Manuals link.

Secure stored jobs

You can protect jobs that are stored on the product by assigning a PIN to them. Anyone who tries to
print these protected jobs must first enter the PIN at the product control panel.

Lock the control panel menus

You can lock various features on the control panel by using the HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the the Security tab.

3. Open the Access Control menu.

4. In the Sign In and Permission Policies area, select which types of users have permission for
each of the features.

5. Click the Apply button.

Lock the formatter

The formatter area, on the back of the product, has a slot that you can use to attach a security cable.
Locking the formatter prevents someone from removing valuable components from it.
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Economy settings

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is
no longer acceptable, consider replacing the print cartridge.

NOTE: This feature is available with the PCL 6 printer driver for Windows. If you are not using that
driver, you can enable the feature by using the HP Embedded Web Server.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Powersave modes

Disable or enable sleep mode

1. At the product control panel, press the Home  button.

2. Open each of the following menus:

a. Administration

b. General Settings

c. Energy Settings

d. Sleep Timer Settings

e. Sleep/Auto Off Timer

3. Select one of the following options:

● Enabled

● Disabled
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Set the sleep timer

Use the sleep timer feature to cause the product to enter sleep mode automatically after a predefined
period of inactivity.

1. At the product control panel, press the Home  button.

2. Open each of the following menus:

a. Administration

b. General Settings

c. Energy Settings

d. Sleep Timer Settings

e. Sleep/Auto Off After

3. Select the appropriate time period, and then press the OK button.

NOTE: The default value is 30 minutes.

Set the sleep schedule

Use the sleep schedule feature to reduce power consumption when the product is inactive. You can
schedule specific times of the day at which the product enters sleep mode or wakes from sleep mode.
You can customize this schedule for each day of the week. To set up a sleep schedule, use the
HP Embedded Web Server.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a
Web browser.

2. Click the General tab.

3. Click the Date and Time link, and then set the current date and time.

4. Click the Apply button.

5. Click the Sleep Schedule link, and then click the Add button to open the sleep schedule
settings.

6. Configure the sleep schedule settings.

7. Click the Apply button.
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Install memory and internal USB devices

Overview

The formatter has the following open slots and ports for expanding the product's capabilities:

● One dual inline memory module (DIMM) slot for upgrading the product with more memory

● Two internal USB ports for adding fonts, languages, and other third-party solutions

To find out how much memory is installed in the product or to find out what is installed in the USB ports,
print a configuration page.

Install memory

You might want to add more memory to the product if you often print complex graphics, print PostScript
(PS) documents, or use many downloaded fonts. Added memory also gives you more flexibility in
supporting job-storage features, such as quick copying.

NOTE: Single inline memory modules (SIMMs) used in previous HP LaserJet products are not
compatible with the product.

Install product memory

This product has one DIMM slot.

CAUTION: Static electricity can damage electronic components. When handling DIMMs, either wear
an antistatic wrist strap or frequently touch the surface of the DIMM antistatic package, then touch bare
metal on the product.

1. Print a configuration page to find out how much memory is installed in the product before adding
more memory.

a. At the product control panel, press the Home  button.

b. Open the following menus:

● Administration

● Reports

● Configuration/Status Pages

● Configuration Page
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2. After the configuration page has printed, turn the product off.

3. Disconnect the power cord and interface cable.

4. Remove the right-side panel by sliding it towards the rear of the product to unlatch it.
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5. Open the access door by pulling on the metal tab.

6. Remove the DIMM from the antistatic package.

CAUTION: To reduce the possibility of damage caused by static electricity, always wear an
electrostatic discharge (ESD) wrist strap or touch the surface of the antistatic package before
handling DIMMs.

7. Hold the DIMM by the edges, and align the notches on the DIMM with the DIMM slot. (Check that
the locks on each side of the DIMM slot are open.)
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8. Press the DIMM straight into the slot, and press firmly. Make sure the locks on each side of the
DIMM snap into place.

9. Close the access door, and press firmly until it snaps into place.

10. Reinstall the right-side panel. Align the tabs on the panel with the slots in the product, and push the
panel toward the front of the product until it latches into place.
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11. Reconnect the interface cable and the power cord.

12. Turn the product on.
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Enable memory

Windows XP, Windows Server
2003, Windows Server 2008,
and Windows Vista

1. Click Start.

2. Click Settings.

3. Click Printers and Faxes (using the default Start menu view) or click
Printers (using the Classic Start menu view).

4. Right-click the product driver icon, and then select Properties.

5. Click the Device Settings tab.

6. Expand the area for Installable Options.

7. Next to Automatic Configuration, select Update Now.

8. Click OK.

NOTE: If the memory is not updated correctly after using the Update Now
option, you can manually select the total amount of memory installed in the product
in the Installable Options area.

The Update Now option overwrites any existing product configuration settings.

Windows 7 1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer properties.

4. Click the Device Settings tab.

5. Expand the area for Installable Options.

6. Next to Automatic Configuration, select Update Now.

7. Click OK.

NOTE: If the memory is not updated correctly after using the Update Now
option, you can manually select the total amount of memory installed in the product
in the Installable Options area.

The Update Now option overwrites any existing product configuration settings.

Mac OS X 10.5 and 10.6 1. From the Apple menu , click the System Preferences menu and then
click the Print & Fax icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Check DIMM installation

After installing the DIMM, make sure that the installation was successful.

1. Turn the product on. Check that the Ready  light is illuminated after the product has gone
through the startup sequence. If an error message appears, a DIMM might have been incorrectly
installed.

2. Print a configuration page.

3. Check the memory section on the configuration page and compare it to the configuration page
that was printed before the memory installation. If the amount of memory has not increased, the
DIMM might not be installed correctly, or the DIMM might be defective. Repeat the installation
procedure. If necessary, install a different DIMM.

NOTE: If you installed a product language (personality), check the "Installed Personalities and
Options" section on the configuration page. This area should list the new product language.

Memory allocation

Utilities or jobs that you download to the product sometimes include resources (for example, fonts,
macros, or patterns). Resources that are internally marked as permanent remain in the product memory
until you turn the product off.

Use the following guidelines if you use the page description language (PDL) ability to mark resources as
permanent. For technical details, see an appropriate PDL reference for PCL or PS.

● Mark resources as permanent only when it is absolutely necessary that they remain in memory
while the product is turned on.

● Send permanent resources to the product only at the beginning of a print job and not while the
product is printing.

NOTE: Overusing permanent resources or downloading them while the product is printing might
affect product performance or the ability to print complex pages.
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Install internal USB devices

The product has two internal USB ports.

1. Turn the product off.

2. Disconnect the power cord and interface cable.

3. Remove the right-side panel by sliding it towards the rear of the product to unlatch it.
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4. Open the access door by pulling on the metal tab.

5. Locate the USB ports near the bottom of the formatter board. Insert the USB device into one of the
ports.

CAUTION: To prevent static electricity from damaging the formatter board, hold the metal
access door with one hand while you insert the USB device with the other hand. If you move away
from the product during this procedure, be sure to touch the metal access door to discharge
electricity before continuing.

6. Close the access door, and press firmly until it snaps into place.
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7. Reinstall the right-side panel. Align the tabs on the panel with the slots in the product, and push the
panel toward the front of the product until it latches into place.

8. Reconnect the interface cable and the power cord.

9. Turn the product on.
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Clean the product
To clean the product exterior, use a soft, water-moistened cloth.

Clean the paper path

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Device Maintenance

● Calibrate/Cleaning

3. Select the Print Cleaning Page item, and press the OK button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Product updates
HP regularly updates features that are available in the product firmware. To take advantage of the most
current features, update the product firmware. To download the most recent firmware upgrade, go to
www.hp.com/go/lj600Series_firmware.
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10 Solve problems

● Self help

● Solve problems checklist

● Restore factory settings

● Interpret control-panel messages

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Improve print quality

● The product does not print or it prints slowly

● Solve walk-up USB printing problems

● Solve connectivity problems

● Solve product software problems with Windows

● Solve product software problems with Mac
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site:
www.hp.com/support/lj600Series

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams. To open the Help system, press the
Help button .
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

1. Make sure the product Ready  light is on. If no lights are on, complete these steps:

a. Check the power-cable connections.

b. Check that the power is turned on.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip
and its voltage is not within specifications, plug the product directly into the wall. If it is
already plugged into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer or network port. Make
sure that the connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection.

3. The control panel should indicate ready status. If an error message appears, resolve the error.

4. Ensure that the paper that you are using meets specifications.

5. Print a configuration page. If the product is connected to a network, an HP Jetdirect page also
prints.

a. At the product control panel, press the Home  button.

b. Open the following menus:

◦ Administration

◦ Reports

◦ Configuration/Status Pages

◦ Configuration Page

c. Press the OK button.

If the pages do not print, check that at least one tray contains paper.

If the page jams in the product, follow the instructions on the control panel to clear the jam.

ENWW Solve problems checklist 169



6. If the configuration page prints, check the following items:

a. If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

b. If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

7. Select one of the following options:

Windows: Click Start, click Settings, and then click Printers or Printers and Faxes.
Double-click the name of the product.

-or-

Mac OS X: Open the Printer Setup Utility or the Print & Fax list, and double-click the line
for the product.

8. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product. The printer driver is on the CD that came with
the product. You can also download the printer driver from this Web site: www.hp.com/support/
lj600Series.

9. Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. If you connected the product to the network, connect the product directly to a computer with
a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the
new connection type that you are using.

Factors that affect product performance

Several factors affect the time it takes to print a job:

● Maximum product speed, measured in pages per minute (ppm)

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB connection

● The product I/O configuration

● The network operating system and configuration (if applicable)

● The printer driver that you are using
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Restore factory settings
1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● General Settings

● Restore Factory Settings

3. Press the OK button.
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Interpret control-panel messages

Control-panel message types

Four types of control-panel messages can indicate the status of or problems with the product.

Message type Description

Status messages Status messages reflect the current state of the product. They inform you of normal product operation
and require no interaction to clear them. They change as the state of the product changes. Whenever
the product is ready, not busy, and has no pending warning messages, the Ready status message
appears if the product is online.

Warning messages Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you press the OK button. Some warning messages are
clearable. If the Clearable Warnings menu in the Display Settings menu is set to the Job
option , the next print job clears these messages.

Error messages Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.

Some error messages are auto-continuable. If the Continuable Events menu in the Display
Settings menu is set to the Auto-Continue option, the product continues normal operation after an
auto-continuable error message appears for 10 seconds.

NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop 
button pauses printing and offers the option to cancel the print job.

Critical-error messages Critical error messages inform you of a product failure. You can clear some of these messages by
turning the product off and then on. These messages are not affected by the Auto-Continue setting.
If a critical error persists, service is required.

Control-panel messages

The product provides robust control panel messaging. When a message appears on the control panel,
follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention”
message, and no steps are shown to resolve the issue, turn the product off then on. Contact HP support
if you continue to experience issues with the product.

For additional information on a variety of topics, press the Help  button.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.
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5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
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Clear jams

Jam locations

If a jam message appears on the control-panel display, look for jammed paper or other print media in
the locations that are indicated in the following illustration. Then follow the procedure for clearing the
jam. You might need to look for paper in other locations than those that are indicated in the jam
message. If the location of the jam is not obvious, look first in the top-cover area underneath the print
cartridge.

When clearing jams, be very careful not to tear jammed paper. If a small piece of paper is left in the
product, it could cause additional jams.

1

4
2

3

5

6

1 Top-cover and print-cartridge areas

2 Optional envelope feeder

3 Tray areas (Tray 1, Tray 2, and optional trays)

4 Optional duplexer

5 Fuser area

6 Output areas (top bin; rear bin; and optional stacker, stapler/stacker, or 5-bin mailbox)

NOTE: Loose toner might remain in the product after a jam and cause temporary print-quality
problems. These problems should clear up within a few pages.

Clear jams from the output areas

Use these procedures to clear jams that occur in the rear output bin or in the optional stacker, stapler/
stacker, or 5-bin mailbox.
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Clear jams from the rear output bin

1. Open the rear output bin.

NOTE: If most of the paper is still inside the
product, it might be easier to remove it through
the top-cover area.

 

 

2. Grasp both sides of the paper, and slowly pull
the paper out of the product. Loose toner might
be on the sheet. Be careful not to spill it on
yourself or into the product.

NOTE: If the jammed paper is difficult to
remove, try opening the top cover all the way
to release pressure on the paper. If the sheet
has torn, or if you still cannot remove it, clear
the jam from the fuser area.

 

3. Close the rear output bin.  

 

4. If a jam message persists, a sheet is still
jammed in the product. Look for the jam in
another location.

 

Clear jams from the optional stacker or stapler/stacker

Paper jams can occur in the optional stacker or the optional stapler/stacker. Staple jams can occur only
in the optional stapler/stacker.
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Clear paper jams from the optional stacker or stapler/stacker

1. At the back of the product, open the door on
the stacker or stapler/stacker, and open the
rear output bin.

 

2. Carefully remove any jammed paper.  

3. Close the door on the stacker or stapler/
stacker, and close the rear output bin.

 

4. If a jam message persists, a sheet is still
jammed. Look for it in another location. Check
the front of the accessory and carefully remove
any jammed paper.

NOTE: The output bin must be pushed down
into the lowest position for printing to continue.

 

Clear staple jams from the optional stapler/stacker

The stapler needs to reload after clearing a staple jam, so the first few documents might not be stapled.
If a print job is sent and the stapler is jammed or is out of staples, the job will still print as long as the
path to the stacker bin is not blocked.
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1. On the right side of the stapler/stacker, turn
the stapler unit toward the front of the product
until the unit clicks into the open position. Pull
outward on the blue staple cartridge to remove
it.

 

2. Rotate the green cover on the end of the staple
cartridge upward, and remove the jammed
staple.

 

3. Insert the staple cartridge into the stapler unit,
and rotate the stapler unit toward the rear of
the product until the unit snaps into place.
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Clear jams from the optional 5-bin mailbox

1. Remove any paper that is in the output bins.  

2. On the back of the 5-bin mailbox, open the
jam-access door.

 

3. If the paper is jammed at the top of the 5-bin
mailbox, pull it straight down to remove it.
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4. If the paper is jammed at the bottom of the 5-
bin mailbox, open the rear output bin, and
then pull straight up on the paper to remove it.

 

5. Close the jam-access door and the rear output
bin.
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Clear jams from the fuser area

Use this procedure only in these situations:

● Paper has jammed inside the fuser and cannot be removed from the top-cover area or the rear-
output area.

● A sheet of paper has torn while you were trying to clear a jam from the fuser.

1. Turn the product off.  

2. Rotate the product so the rear is facing you. If
an optional duplexer is installed, lift it and pull
it straight out. Set it aside.

 

3. Disconnect the power cord.

WARNING! The fuser is very hot. To avoid
minor burns, allow the fuser to cool before
removing it from the product.
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4. Open the rear output bin.  

 

5. Remove the rear output bin. Place your finger
near the left-side hinge, and push firmly to the
right until the hinge-pin clears the hole inside
the product. Rotate the output bin outward to
remove it.

 

6. If paper is visible, remove it.

If paper is not visible, push up on the two blue
levers on the sides of the fuser, and pull the
fuser straight out.

 

7. Remove the jammed paper. If necessary, lift
the black plastic guide that is located on the
top of the fuser to gain access to the jammed
sheet.

CAUTION: Do not use a sharp or metal
object to clear paper from the fuser area. You
might damage the fuser.
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8. Push the fuser firmly into the product until the
blue levers on both sides click into place.

 

9. Reinstall the rear output bin. Insert the right
hinge-pin into the hole inside the product. Push
inward on the left hinge, and slide it into the
hole inside the product. Close the rear output
bin.

 

10. Plug the power cord into the product.  

11. Replace the optional duplexer, if it was
removed.
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12. Turn the product on.  

13. If a jam message persists, a sheet is still
jammed in the product. Look for the jam in
another location.

 

Clear jams from the optional duplexer

1. Lift the optional duplexer up and then pull it
out to remove it.

 

2. Remove any paper that is on top of Tray 2.
(You might need to reach inside the product.)
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3. Slowly pull any paper out of the optional
duplexer.

 

4. Insert the optional duplexer into the product.  

5. If a jam message persists, a sheet is still
jammed in the product. Look for the jam in
another location.
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Clear jams from the trays

Use these procedures to clear jams from the trays.

Clear jams from Tray 1

1. Slowly pull the jammed paper out of the
product.

 

Clear jams from Tray 2 or an optional 500-sheet tray

1. Slide the tray out of the product, lift it slightly,
and remove any damaged paper from the
tray.

 

2. If the edge of the jammed paper is visible in
the feed area, slowly pull the paper down and
out of the product. (Do not pull the paper
straight out, or it will tear.) If the paper is not
visible, look in the next tray or in the top-cover
area.
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3. Make sure that the paper is flat in the tray at
all four corners and below the maximum-height
indicators.

 

4. Slide the tray into the product.  

5. Press the OK button to clear the jam message.  

6. If a jam message persists, a sheet is still
jammed in the product. Look for the jam in
another location.

 

Clear jams from the optional 1,500-sheet tray

1. Open the front door of the tray.  
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2. If the edge of the jammed paper is visible in
the feed area, slowly pull the paper down and
out of the product. (Do not pull the paper
straight out, or it will tear.) If the paper is not
visible, look in the top-cover area.

 

3. Make sure that the paper does not exceed the
fill marks on the paper guides, and that the
front edge of the stack is aligned with the
arrows.

 

4. Close the front door of the tray.  

5. Press the OK button to clear the jam message.  

6. If a jam message persists, a sheet is still
jammed in the product. Look for the jam in
another location.
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Clear jams from the optional envelope feeder

This procedure applies only to jams that occur when you are using an optional envelope feeder.

1. Remove any envelopes that are loaded in the
optional envelope feeder. Lower the envelope
weight and lift the tray extension up, to the
closed position.

 

2. Grasp both sides of the optional envelope
feeder and carefully pull it out of the product.

 

3. Slowly remove any jammed envelopes from
the optional envelope feeder.

 

4. Slowly remove any jammed envelopes from
the product.
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5. Reinstall the envelope feeder.  

6. Press the OK button to clear the jam message.  

7. If a jam message persists, an envelope is still
jammed in the product. Look for the jam in
another location.

 

8. Replace the envelopes, making sure that you
push the bottom envelopes in slightly further
than the top envelopes.

 

Clear jams from the top-cover and print-cartridge areas

1. Open the top cover.  

2. Remove the print cartridge.

CAUTION: To prevent damage to the print
cartridge, do not expose it to light for more
than a few minutes. Cover the print cartridge
with a sheet of paper while it is outside of the
product.
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3. Use the green handle to lift the paper-access
plate. Slowly pull the jammed paper out of the
product. Do not tear the paper. If paper is
difficult to remove, try clearing it from the tray
area.

 

4. Open Tray 1 and remove the envelope
accessory cover. If paper is present, remove it.

 

5. Rotate the paper guide to check for additional
jammed paper underneath. If jammed paper is
present, remove it.

 

       

6. Replace the envelope accessory cover and
close Tray 1.
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7. Reinstall the print cartridge and close the top
cover.

 

8. If a jam message persists, jammed paper is still
in the product. Look for the jam in another
location.

 

Change jam recovery

This product provides a jam recovery feature that reprints jammed pages. The following options are
available:

● Auto — The product attempts to reprint jammed pages when sufficient memory is available. This
is the default setting.

● Off — The product does not attempt to reprint jammed pages. Because no memory is used to
store the most recent pages, performance is optimal.

NOTE: When using this option, if the product runs out of paper and the job is being printed on
both sides, some pages can be lost.

● On — The product always reprints jammed pages. Additional memory is allocated to store the
last few pages printed. This might cause overall performance to suffer.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Administration

● General Settings

● Jam Recovery

3. Select the appropriate setting, and then press the OK button.
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Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver.

● Use paper that meets HP specifications for this product.

● Clean the product as necessary.

● Replace print cartridges when they are reaching the end of their estimated life and print quality is
no longer acceptable.

● Use the printer driver that best meets your printing needs.

Select a paper type

1. Open the printer driver, click the Properties or Preferences button, and then click the Paper/
Quality tab.

2. Select a type from the Type is drop-down list.

3. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the
following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. At the product control panel, press the Home  button.

2. Open the following menus:

● Device Maintenance

● Calibrate/Cleaning

3. Select the Print Cleaning Page item, and press the OK button to print the page.

4. The cleaning process can take several minutes. When it is finished, discard the printed page.

Check the print cartridge

Check the print cartridge, and replace it if necessary, if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft or EconoMode print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.
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Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge.

Genuine HP print cartridge 1. The product control panel or the supplies status page indicates Very Low
status when the cartridge has reached the end of its designated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repeating defects information in this document to identify the cause of the
problem.
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Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

Download additional printer drivers from this Web site: www.hp.com/go/lj600Series_software.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/lj600Series.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.
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Solve walk-up USB printing problems
● The Retrieve From USB menu does not open when you insert the USB accessory

● The file does not print from the USB storage accessory

● The file that you want to print is not listed in the Retrieve From USB menu

The Retrieve From USB menu does not open when you insert the
USB accessory

1. You might be using a USB storage accessory or a file system that this product does not support.
Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file
systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage accessory.

3. The USB storage accessory might have multiple partitions. (Some USB storage accessory
manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat
the USB storage accessory to remove the partitions, or use a different USB storage accessory.

4. The USB storage accessory might require more power than the product can provide.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Use a USB storage accessory that has its own power supply or that requires less power.

5. The USB storage accessory might not be functioning correctly.

a. Remove the USB storage accessory.

b. Turn the product off and then on.

c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the Retrieve From USB
menu

1. You might be trying to print a file type that the USB printing feature does not support. The product
supports .pdf, .prn, .pcl, .ps, and .cht file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the
number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case,
the product replaces the file names with characters from a different character set. Rename the files
using ASCII characters.
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Solve connectivity problems

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.
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3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve product software problems with Windows

A printer driver for the product is not visible in the Printer folder

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Try plugging the USB cable into a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB
and power cables. Try a new cable.

3. Verify that the IP address on the configuration page matches the IP address for the software port.
Use one of the following procedures:

Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista

a. Click Start.

b. Click Settings.

c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the
Classic Start menu view).

d. Right-click the product driver icon, and then select Properties.

e. Click the Ports tab, and then click Configure Port.

f. Verify the IP address, and then click OK or Cancel.

g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Windows 7

a. Click Start.

b. Click Devices and Printers.

c. Right-click the product driver icon, and then select Printer properties.

d. Click the Ports tab, and then click Configure Port.

e. Verify the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and then reinstall the driver using the
correct IP address.
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Solve product software problems with Mac
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print &
Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected
product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in
the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and connect the cable directly to the USB port on the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB
connection

If you connected the USB cable before you installed the software, you might be using a generic printer
driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Product supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using HP software Use the HP Embedded Web Server on page 147
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Part numbers
The following list of accessories was current at the time of printing. Ordering information and
availability of the accessories might change during the life of the product

Paper-handling accessories

Item Description Part number

Optional 500-sheet tray and feeder unit Optional tray to increase paper
capacity. Holds Letter, A4, Legal, A5,
B5 (JIS), Executive, and 8.5 x 13 inch
paper sizes.

The product can accommodate up to
four optional 500-sheet feeders.

CE998A

Optional 1,500-sheet tray and feeder
unit

Optional tray to increase paper
capacity. Holds Letter, Legal, and A4
paper sizes.

CE398A

Custom media cassette Enables the product to print A6-size
paper from Tray 2.

CB527A

Envelope feeder Holds up to 75 envelopes. CE399A

Duplexer (duplex printing accessory) Allows automatic printing on both sides
of the paper.

CF062A

500-sheet stacker Provides an additional output bin that
holds 500 sheets.

CE404A

500-sheet stapler/stacker Allows for high-volume output with
automatic job finishing. Staples up to 15
sheets of paper.

CE405A

HP 5-bin mailbox Provides five output bins that you can
use to sort jobs.

CE997A

Printer stand Provides stability when multiple optional
trays are installed. The stand has casters
so you can easily move the product.

CB525A

Customer self-repair parts

The following Customer Self-Repair parts are available for your product.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are
willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot
support is not provided under your HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request
for no additional charge during the product warranty period.
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Item Description1 Self-replacement options Part number

HP LaserJet black print
cartridge

Standard black cartridge Mandatory CE390A

HP LaserJet black print
cartridge

High-capacity black cartridge

NOTE: M602 and M603
models only

Mandatory CE390X

1,000-staple cartridge Provides three staple
cartridges.

Mandatory Q3216A

Preventive maintenance kit Includes a replacement fuser,
a transfer roller, a transfer-
roller tool, a Tray 1 roller,
eight feed rollers, and one
pair of disposable gloves.
Includes instructions for
installing each component.

Mandatory 110-volt product maintenance
kit: CF064A

220-volt product maintenance
kit: CF065A

44 x 32-pin DDR2 memory
DIMM, 512 MB

Boosts the ability of the
product to handle large or
complex print jobs.

Mandatory CE483A

1 For more information, go to www.hp.com/go/learnaboutsupplies.

Cables and interfaces

Item Description Part number

HP Jetdirect print server devices HP Jetdirect 2700w USB Wireless
device

J8026A

USB cable 2-meter (6-ft) A-to-B cable C6518A

210 Appendix A   Product supplies and accessories ENWW

http://www.hp.com/go/learnaboutsupplies


B Service and support

● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● Data stored on the print cartridge

● End User License Agreement

● Customer self-repair warranty service

● Customer support

● Repack the product
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Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet 600 M601n, M601dn, M602n, M602dn,
M602x, M603n, M603dn, M603xh

One-year return-to-bench repair warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace
products which prove to be defective. Replacement products may be either new or equivalent in
performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you
will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some
countries/regions, states or provinces do not allow limitations on the duration of an implied warranty,
so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights
and you might also have other rights that vary from country/region to country/region, state to state, or
province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE
YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR
ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL,
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED
IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the
exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may
not apply to you.
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THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED
AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE
FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Data stored on the print cartridge
The HP print cartridges used with this product contain a memory chip that assists in the operation of the
product.

In addition, this memory chip collects a limited set of information about the usage of the product, which
might include the following: the date when the print cartridge was first installed, the date when the print
cartridge was last used, the number of pages printed using the print cartridge, the page coverage, the
printing modes used, any printing errors that might have occurred, and the product model. This
information helps HP design future products to meet our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used
to identify a customer or user of the print cartridge or their product.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and
recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this
print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the memory chip cannot be used in an HP
product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL
TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT
ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF
YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE
SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE
PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHER
HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software (“HP
Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is in a file such as
“license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party
License. If the Third Party Licenses include licenses that provide for the availability of source code
(such as the GNU General Public License) and the corresponding source code is not included with
the Software, then check the product support pages of HP's website (hp.com) to learn how to
obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing,
copying, storing, loading, executing, displaying, or otherwise using the HP Software. You
may not modify the HP Software or disable any licensing or control feature of the
HP Software. If this Software is provided by HP for Use with an imaging or printing product
(for example, if the Software is a printer driver, firmware, or add-on), the HP Software may
only be used with such product (“HP Product”). Additional restrictions on Use may appear in
the User Documentation. You may not separate component parts of the HP Software for Use.
You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the
HP Software, provided each copy contains all the original HP Software’s proprietary notices
and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may
no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other
terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other
terms will prevail.
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4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of
the HP Software to another end user. Any transfer will include all component parts, media,
User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer
may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user
receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software,
your license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer
the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright
notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s
privacy policy. HP will not use such information in a form that personally identifies you except to
the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited
to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL
PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental
or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All
Software is commercial computer software within the meaning of the applicable acquisition
regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use,
duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government
subcontractor is subject solely to the terms and conditions set forth in this End User License
Agreement, except for provisions which are contrary to applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software,
including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you in
this EULA.
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Customer self-repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period,
HP identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part
directly to you for replacement. There are two categories of CSR parts: 1) Parts for which customer self
repair is mandatory. If you request HP to replace these parts, you will be charged for the travel and
labor costs of this service. 2) Parts for which customer self repair is optional. These parts are also
designed for Customer Self Repair. If, however, you require that HP replace them for you, this may be
done at no additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether a
defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/lj600Series

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/go/lj600Series_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Repack the product
If HP Customer Care determines that your product needs to be returned to HP for repair, follow these
steps to repack the product before shipping it.

CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain any DIMM cards that you have purchased and installed in the product.

CAUTION: Static electricity can damage electronic parts. When handling DIMMs, either wear
an antistatic wrist strap, or frequently touch the surface of the DIMM antistatic package and then
touch bare metal on the product.

2. Remove and retain the print cartridge.

CAUTION: It is extremely important to remove the print cartridge before shipping the product. A
print cartridge that remains in the product during shipping can leak and cover the product engine
and other parts with toner.

To prevent damage to the print cartridge, avoid touching the roller on it, and store the print
cartridge in its original packing material or so that it is not exposed to light.

3. Remove and retain the power cable, interface cable, and optional accessories.

4. If possible, include print samples and 50 to 100 sheets of paper or other print media that did not
print correctly.

5. In the U.S., call HP Customer Care to request new packing material. In other areas, use the
original packing material, if possible. Hewlett-Packard recommends insuring the equipment for
shipment.
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Operating environment
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Physical specifications
Table C-1  Product dimensions and weights

Product model Height Depth Width Weight

n and dn models 394 mm (15.5 in) 4515 mm (17.8 in) 425 mm (16.75 in) 23.6 kg (51.9 lb)

x and xh models 514 mm (20.25 in) 451 mm (17.8 in) 425 mm (16.75 in) 30.4 kg (66.8 lb)

Optional 500-sheet feeder 121 mm (4.8 in) 448.4 mm (17.7 in) 415 mm (16.3 in) 6.7 kg (14.7 lb)

Optional 1500-sheet tray 263.5 mm (10.4 in) 511.5 mm (20.1 in) 421 mm (16.6 in) 13 kg (28.7 lb)

Optional duplexing unit 154 mm (6.1 in) 348 mm (13.7 in) 332 mm (13.1 in) 2.5 kg (5.5 lb)

Optional envelope feeder 113 mm (4.4 in) 354 mm (13.9 in) 328 mm (12.9 in) 2.5 kg (5.5 lb)

Optional stapler/stacker 371 mm (14.6 in) 430 mm (16.9 in) 387 mm (15.2 in) 4.2 kg (9.3 lb)

Optional stacker 304 mm (12 in) 430 mm (16.9 in) 378 mm (14.9 in) 3.2 kg (7.1 lb)

Optional multi-bin mailbox 522 mm (20.6 in) 306 mm (12 in) 353 mm (13.9 in) 7.0 kg (15.4 lb)

Optional printer stand 114 mm (4.5 in) 653 mm (25.7 in) 663 mm (26.1 in) 13.6 kg (30 lb)

Table C-2  Product dimensions with all doors and trays fully opened

Product model Height Depth Width

n and dn models 394 mm (15.5 in) 864 mm (34.0 in) 425 mm (16.75 in)

x and xh models 514 mm (20.25 in) 864 mm (34.0 in) 425 mm (16.75 in)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/lj600Series_regulatory for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Operating environment
Table C-3  Necessary conditions

Environmental condition Printing Storage/standby

Temperature (product and print
cartridge)

7.5° to 32.5°C (45.5° to 90.5°F) 0° to 35°C (32° to 95°F)

Relative humidity 5% to 90% 35% to 85%
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of Conformity

● Safety statements
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy, and if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class A limits of Part 15 of FCC rules.
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Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production

This product generates no appreciable ozone gas (O3).

Power consumption

Power usage drops significantly while in Sleep mode, which saves natural resources and saves money
without affecting the high performance of this product. Hewlett-Packard printing and imaging
equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection
Agency's ENERGY STAR specifications for imaging equipment. The following mark will appear on
ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge. HP does not recommend
the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the
mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable,
consider replacing the print cartridge.

Paper use

This product’s optional automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.
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HP LaserJet print supplies

It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-addressed
shipping label contained in the box. To use the UPS label, give the package to the UPS driver during
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your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS Ground
pickup will be charged normal pick-up rates) For the location of your local UPS drop-off center, call
1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal Service
carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground pickup will be
charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at any U.S. Post
Office or any FedEx shipping center or store. For the location of your nearest U.S. Post Office, please
call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx shipping center/
store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:

HP LaserJet Enterprise 600 M601, M602, and M603 Series Printer

Type Carbon monofluoride lithium

Weight 1.5 g

Location On formatter board

User-removable No
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For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop
where you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be
found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information

To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system
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● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of Conformity

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-1101-00-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Enterprise 600 M601, M602, and M603

 Including:

CE998A – 500-sheet paper tray

CF062A – Duplexer

Regulatory Model Number2) BOISB-1101-00

Product Options: ALL

Print Cartridges: CE390A, CE390X

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006 +A11

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class A1), 3)

EN 61000-3-2:2006

EN 61000-3-3:2008

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class A1)/ ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC and

carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. 3) The product meets the requirements of EN55022 & CNS13438 Class A in which case the following applies: “Warning – This is a
class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take
adequate measures”.

Boise, Idaho USA

September 2011

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.eu/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class A requirements.

« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (China)

EMC statement (Korea)

EMI statement (Taiwan)

Product Stability

Do not extend more than one paper tray at a time.

Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet 600 M601n, M601dn, M602n, M602dn, M602x, M603n, M603dn, M603xh,
laserkirjoitin on käyttäjän kannalta turvallinen luokan 1 laserlaite. Normaalissa käytössä kirjoittimen
suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle. Laitteen turvallisuusluokka on määritetty
standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.
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HUOLTO

HP LaserJet 600 M601n, M601dn, M602n, M602dn, M602x, M603n, M603dn, M603xh -
kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita. Laitteen saa avata ja huoltaa
ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota
väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa lueteltuja,
käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W
Luokan 3B laser.

GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert warden.
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Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Index

Symbols/Numerics
1,500-sheet tray

loading 81
paper jams 187

500-sheet tray
loading 79
paper jams 186

A
accessories

ordering 208
part numbers 209

acoustic specifications 224
Administration menu, control

panel 18
AirPrint 52
alerts, e-mail 51
anticounterfeit supplies 95

B
Backup/Restore menu, control

panel 32
batteries included 229
bins, output

jams, clearing 175
selecting 87

booklets
creating (Windows) 132

both sides, printing on
turning on (Mac) 51

browser requirements
HP Embedded Web Server

147
buttons, control panel 12

C
Calibrate/Cleaning menu, control

panel 32
Canadian DOC regulations 234

canceling
print job 54

canceling a print request
(Windows) 108

card stock
output bin, selecting 87

cartridges
non-HP 95
recycling 95, 228
replacing 97
status messages 12
storage 95
warranty 214

cartridges, staple
loading 99

cautions iii
cleaning

paper path 166, 194
product 166

clearing jams
1,500-sheet tray 187
500-sheet tray 186
duplexer 184
envelope feeder 189
fuser area 181
locations 175
output area 175
staple 177
top-cover 190
Tray 1 186

Configuration Pages
description 146

configuring
IP address 63

connection
USB with Mac 46
USB with Windows 60

connectivity
solving problems 201

control panel
Administration menu 18
Backup/Restore menu 32
buttons 12
Calibrate/Cleaning menu 32
cleaning page, printing 166
display 12
Display Settings menu 23
General Settings menu 18
lights 12
Manage Supplies menu 24
Manage Trays menu 25
messages, numerical list 104
messages, types of 172
Multi-Bin Mailbox Settings

menu 26
Network Settings menu 27
Print Settings menu 21
Reports menu 18
security 153
Service menu 33
settings 39, 50
Stapler/Stacker Settings menu

26
Troubleshooting menu 31
USB Firmware Upgrade menu

33
control panel menus

retrieve job 14, 15
conventions, document iii
copies

changing number of
(Windows) 110

counterfeit supplies 95
cover pages

printing (Mac) 55
printing on different paper

(Windows) 128

ENWW Index 239



Current Settings Page
description 146

custom print settings (Windows)
111

custom-size paper settings
Macintosh 54

customer support
online 220
repacking product 221

D
default gateway, setting 66
defects, repeating 103
deleting

stored jobs 138
dimensions, product 224
DIMMs

installing 156
part numbers 210
verifying installation 162

Display Settings menu, control
panel 23

disposal, end-of-life 229
document conventions iii
double-sided printing (duplexing)

turning on (Mac) 51
drivers

changing paper types and
sizes 72

changing settings (Mac) 50
changing settings (Windows)

39
paper types 75
presets (Mac) 54
settings 39
settings (Mac) 54
settings (Windows) 109
supported (Windows) 36
universal 37

duplex alignment
setting 141

duplex printing (double-sided)
settings (Windows) 116
turning on (Mac) 51

duplex printing accessory
jams 184
part number 209

duplex settings, changing 68

E
e-mail alerts 51
EconoMode setting 95, 154
economy settings 154
EIO cards

installing 156
electrical specifications 224
Embedded Web Server

features 147
Embedded Web Server (EWS)

assigning passwords 152
end-of-life disposal 229
envelope feeder

paper jams 189
part number 209

envelopes
loading 84
output bin, selecting 87

environment for product
specifications 224

environmental features 5
Environmental Product Stewardship

Program 227
error messages

control panel 172
e-mail alerts 51
lights, control panel 12
numerical list 104
types of 172

errors
software 203

European Union, waste disposal
230

Explorer, versions supported
HP Embedded Web Server

147

F
FCC regulations 226
features 2
feed rollers, replacing 100
File Directory Page

description 146
file upload, Mac 51
Finnish laser safety statement 235
firmware

update, Mac 51
firmware, downloading new 166

first page
printing on different paper

(Windows) 128
use different paper 55

fonts
permanent resources 162
upload, Mac 51

formatter
security 153

forms
printing (Windows) 123

fraud Web site 95
fuser

paper jams 181
replacing 100

G
gateway, setting default 66
general configuration

HP Embedded Web Server
148

General Settings menu, control
panel 18

H
hard disks

encrypted 152
heavy paper

output bin, selecting 87
help

printing options (Windows)
110

Help button, control panel 12
HP Customer Care 220
HP Embedded Web Server 42

features 147
general configuration 148
HP Web Services 150
information pages 148
network settings 150
other links list 150
print settings 149
security settings 150
troubleshooting tools 149

HP ePrint
description 42, 52

HP ePrint, using 122
HP fraud Web site 95
HP Printer Utility 51
HP Universal Print Driver 37

240 Index ENWW



HP Utility 51
HP Utility, Mac 51
HP Web Jetadmin 42, 151
HP Web Services

enabling 150
HP Web Services, enabling 122
HP-UX software 43
humidity

specifications 224

I
information pages

HP Embedded Web Server
148

printing 146
installing

memory (DIMMs) 156
product on wired networks,

Mac 47
product on wired networks,

Windows 63
software, USB connections 60
software, wired networks 64
USB devices 163

Internet Explorer, versions
supported

HP Embedded Web Server
147

IP address
configuring 63

IP Security (IPsec) 152
IPv4 address 66
IPv6 address 67

J
jams

1,500-sheet tray 187
500-sheet tray 186
causes of 173
duplexer 184
envelope feeder 189
fuser area 181
locations 175
output bin 175
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Troubleshooting 31
USB Firmware Upgrade 33

menus, control-panel
retrieve job 14, 15

mercury-free product 229
messages
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Windows 130
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Sleep Schedule
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HP Printer Utility 51
HP Web Jetadmin 42
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special media
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staple jams 177
staple options

selecting (Windows) 135
stapler/stacker
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status
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control panel messages 12
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(Windows) 108
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creating (Windows) 137
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receiving notification when
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security 153
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temporary copies (Windows)
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(Windows) 139
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support
online 220
repacking product 221

supported paper 73
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parameters 66
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top cover
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transparencies
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printing (Windows) 125

Tray 1
loading 78
paper jams 186

Tray 2
loading 79
paper jams 186

Tray 3
loading 79
paper jams 186
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trays
configure 85
load 78
loading 1,500-sheet tray 81
loading 500-sheet tray 79
loading Tray 1 78
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paper jams 175, 186, 187
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troubleshooting
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duplexer jams 184
envelope feeder jams 189
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fuser-area paper jams 181
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output bin jams 175
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repeating defects 103
staple jams 177
top-cover paper jams 190

Tray 1 paper jams 186
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problems 199
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Troubleshooting menu, control
panel 31

troubleshooting tools
cleaning page 166
control-panel messages 104,
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HP Embedded Web Server
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settings (Windows) 116
turning on (Mac) 51

U
uninstalling Mac software 49
uninstalling Windows software 41
universal print driver 37
UNIX software 43
updates, downloading product

166
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USB configuration, Mac 46
USB configuration, Windows 60
USB devices
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USB Firmware Upgrade menu,
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(Windows) 141

W
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warnings iii
warranty

customer self repair 219
license 216
print cartridges 214
product 212
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Web printing

HP ePrint 42, 52
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HP Web Jetadmin,

downloading 151
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Material Safety Data Sheet
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Windows

driver settings 39
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supported operating systems
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